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Preface

This manual provides a detailed description of the capabilities of the Job
Access & Management System (JAMS). The information contained within
this manual is of interest to those who are responsible for installing,
implementing and using this software package.

Additional Documentation
JAMS is designed to run under the OpenVMS and Windows NT/2000
operating systems and this manual assumes that the reader has a basic
understanding of these operating system environments. The following
OpenVMS documentation may also be helpful when using JAMS.

• Guide to using Command Procedures provides information on
command procedures and batch jobs.

• DCL Dictionary provides information on the SUBMIT and PRINT
commands and their qualifiers.

• Guide to Programming Resources provides information on developing
programs in the OpenVMS environment.

• Guide to OpenVMS System Security provides information on Access
Control List (ACL) based security.

Conventions
The following conventions are used in this manual:

Convention Description

UPPERCASE Uppercase words and letters used in examples indicate
text that you should type exactly as shown.

lowercase Lowercase words and letters used in examples indicate
text that you should substitute a word or value of your
choice.

[ ] Brackets ([ ]) indicate optional elements.

{} Braces ({}) indicate required elements.

... An ellipse (...) indicates that the preceding item can be
repeated.

CTRL/x The text CTRL/x indicates that you should press and hold
the key labeled Ctrl while you press the key indicated by
the x (for example CTRL/C, CTRL/Z).

Key Name Text enclosed in a box indicates that you should press
the key whose name is enclosed by the box.

Gold/x Key names which begin with Gold/ indicate that you
should first press and release the Gold key (PF1 on most
keyboards) and then press the key indicated by the x.

x



1 Overview of JAMS

This chapter provides an overview of the Job Access and Management
System, also known as JAMS.

1.1 Introduction
The Job Access and Management System (JAMS) is designed to automate
and enhance the batch processing capabilities provided by the OpenVMS,
Windows NT/2000, and Unix/Linux operating systems. JAMS provides
those in charge of operations as well as the general end-user, with the
ability to request, monitor and control the processing of batch jobs.

JAMS provides the control mechanisms which allow you to give end-users
the ability to request batch processing and yet, you can still retain control
of how, and when, the requested jobs are executed. In addition to allowing
end-users to submit their own jobs, JAMS allows you to schedule jobs for
unattended execution.

JAMS is scalable, tightly integrated with the operating system,
customizable, and yet is ready to provide benefits right-out-of-the-box.
You can use JAMS as is, or customize it to your needs without worry that
future JAMS upgrades will displace the work you have done. Properly
implemented, JAMS will both enhance and simplify your batch scheduling
which increases your system’s reliability and lowers your total cost of
operations.

Visit our web site at http://JAMS.mvpsi.com/ for the latest information
regarding JAMS.

1.2 Capabilities of the Job Access and Management System
The Job Access and Management System was designed to enhance and
control the entire life cycle of a batch job, from the initial end-user request
for processing, to the scheduling of the job (or jobs) which need to be run,
to monitoring the jobs for successful completion, to the distribution of the
information produced by the jobs.

JAMS provides the following key benefits:

• Jobs can run on OpenVMS, Windows NT/2000, or Unix/Linux.

• Without regard to platform, JAMS will honor and enforce resource
requirements, triggers, and job dependencies.

• Global variables are available to any batch job running on any system.

• Batch jobs can execute in queues, run as detached processes, or specific
one-line commands can be issued to run on any given node.

• With resource based scheduling, you can ensure that the workload on
your systems is managed.
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Overview of JAMS

• You can give end-users simple, secure, access to batch processing.

• Recurring Jobs can be automatically submitted using time based or
event based schedules.

• Batch job execution history is immediately available on-line.

• You can use the JAMS Job Monitor to manage and track all batch
processing.

• You do not need to make any changes to your existing batch jobs.

• Recurring jobs may have date parameters and the correct date will be
supplied when JAMS automatically submits the job.

• JAMS can notify people via OpenVMS Mail, broadcasts or OPCOM
messages when a batch job fails, runs too long, runs too quickly or is
stalled.

• A job may have up to 255 parameters.

• You can use JAMS to provide simple, standard, and secure batch job
templates.

• Parameter substitution can take place in data areas of DCL, script,
and batch command procedures.

• The JAMS monitor allows you to monitor and manage batch jobs
from from all three interface options (screen, DECwindows/MOTIF,
Windows).

1.2.1 User Access to Batch Processing
JAMS is designed to enable end-users to take some responsibility for
their batch processing. JAMS provides a simple interface to batch job
submission as well as functions which allow a user to display and monitor
their batch jobs. The end-user is best able to determine when, or if, a job
should be executed and what the parameter values for the job should be.

While end-users can take responsibility for directly submitting most of
their jobs, the Data Center management still controls the execution and
definition of the jobs. Data Center personnel define the jobs and attributes
such as execution method, scheduling windows, dependencies, required
resources, default parameter values, job execution priority etc. The job
can be required to be submitted on hold, meaning that a Data Center
Professional must release the job before it will actually run.

In addition to time or trigger based automatic batch job submission, JAMS
provides five additional means of requesting or submitting a batch job:

• Menu driven, video forms based system.

• DECwindows/Motif based interface.

• Command line interface similar to the OpenVMS SUBMIT command.

• Windows 9x/NT/2000.

• Callable interface which you can access from your applications.
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These interfaces are used to submit ad hoc jobs, jobs which are not
regularly scheduled via scheduled times or triggers.

1.2.1.1 Menu based job submission
The menu based system provides a simple means to locate and submit
a batch job. The end-user is provided with a menu of jobs which they
may submit. The menu hierarchy and content can be customized to your
specific needs. Once the end-user selects a job, they may be presented with
a ‘‘fill in the blanks’’ type of video form which is used to obtain values for
the parameters which the job needs. These parameters can be edited and
verified before the job is submitted. With the built-in security model, users
can only submit those jobs which they have clearance to submit. Users
will also have the ability to modify job output characteristics, such as the
number of copies of a report, or the print queue it should print on.

1.2.1.2 DECwindows/Motif based job submission
The DECwindows/Motif based system is similar to the menu based system
except that it is designed to run under the DECwindows/Motif graphical
user interface.

1.2.1.3 Command line interface
The command line interface is similar to the OpenVMS SUBMIT
command. By using the JAMS SUBMIT command, users have access
to the enhancements provided by JAMS including:

• Forms based parameter entry.

• Modification of report destination queues, forms etc.

• Enhanced parameter editing and substitution.

• Command file template expansion.

• Initiating Jobs on OpenVMS which may actually execute on Windows
NT/2000 or UNIX/Linux.

1.2.1.4 Windows 9x/NT/2000 based job submission
Windows 9x/NT/2000 is similar to both the DECwindows/Motif based
system and the menu based system. This interface is designed to run
under the Windows graphical user interface standard.

1.2.1.5 Callable interface
The callable interface allows you to integrate the Job Access and
Management System into your custom OpenVMS software. All of the
capabilities of the JAMS Submit sub-system are available with the callable
interface. By calling the appropriate JAMS routine, you can present the
end-user with a menu of batch jobs to submit or submit a specific job.
The callable interface is explained in more detail in the JAMS Reference
Manual.
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1.2.2 Managing Batch Jobs
JAMS provides a high performance dynamic job monitoring and
management system. On OpenVMS systems, JAMS even monitors those
jobs which were not submitted by JAMS. The information is constantly
updated and always up to date. The Monitor never scans the OpenVMS
batch queues so performance is not negatively affected, no matter how
many people are running the Monitor.

A properly authorized user can use the JAMS Monitor to manage jobs.
A job may be rescheduled, aborted, held, released or restarted all from
within the JAMS Monitor.

The JAMS Monitor has three interfaces:

• Screen.

• DECwindows/Motif.

• Windows.

1.2.3 Tracking Batch Job History
One of the most basic functions of JAMS is to monitor and track the
status of batch jobs. JAMS maintains a history of batch jobs, tracks the
history for those jobs which were submitted by JAMS as well as those
jobs submitted by other means (OpenVMS SUBMIT command etc.) This
history information is available on-line and is updated immediately after
the status of a job has changed.

JAMS also monitors jobs in order to resolve job dependencies. Job
dependencies insure that all prerequisite processing has been completed
before a job is released for execution.

1.2.4 Remote Access
JAMS provides the ability to access JAMS Servers on remote nodes. Once
a person has connected to a remote node, they can submit jobs, monitor
batch processing and search the JAMS history information.

You can connect to an unlimited number of nodes and it is very easy to
toggle between nodes. This capability makes it very easy to manage the
batch processing of an entire distributed organization from a single point.

1.2.5 Recurring Jobs
Virtually every site has batch jobs which must be submitted on a regular
basis. These recurring jobs can be automatically submitted by JAMS.
There is virtually no limit to the number of ways to specify the date and
time at which a recurring job should be scheduled to execute. You can also
define event based schedules.
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The Resource functionality within JAMS is designed to limit the number
of jobs running simultaneously which require the same resources. Once
resource requirements are defined for your jobs you can rest assured that
the workload on your servers will be controlled.

1.2.5.1 Time Based Schedules
The specification of a scheduled time includes an English language date
selection, a time of day and whether or not to run the job on non-work
days.

JAMS capability for understanding English language representations
of dates is quite extensive. JAMS can understand simple dates such
as ‘‘MONDAY’’ or ‘‘DAILY’’ and complex constructs such as ‘‘FIRST
WORKDAY OF FISCAL QUARTER’’.

These English date specifications are used to define a job’s scheduled day
and for establishing the default value for date parameters to jobs. For
more information on this capability, refer to Chapter 10, Entering Generic
Date Specifications.

When you Setup a recurring Job you must specify the value of any
parameters which the Job requires. If a parameter is a date, you can
specify an absolute date or a date which is relative to the date on which
the job is submitted.

You have the option of enabling any user to define recurring jobs. An end-
user who wants a specific report every Monday morning can Setup their
request as a recurring job and the report will be ready for their review
every Monday morning.

1.2.5.2 Event Based Schedules
JAMS allows you to define Triggers which consist of a list of events and a
list of actions. When all of the specified events occur, the list of actions is
automatically performed. An event can be the successful or unsuccessful
completion of a specific Job. An event can also be a boolean expression
based upon the value of a JAMS Variable.

A Trigger’s list of actions is a list of Jobs to be submitted when the Trigger
is fired. For each action Job you can specify a schedule date and time for
the Job to start. For example, a Trigger could fire at 3:00 pm Tuesday
which schedules a Job to run at 2:00 am Sunday.

1.2.6 Maintaining Schedules
One of the most important aspects of managing a data center is scheduling
the workload of your computer systems. While the recurring job
capabilities of the Job Access and Management System can help maintain
your schedule, a recurring job is not always practical.

Batch processing which is run only on request can still be given a
scheduled date and time for execution. When a user requests a job,
JAMS will specify the scheduled time when it submits the job. A user can
override this scheduled time when they request the job.
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Keep in mind that if you elect to use JAMS Resources, jobs may not
immediately run due to the defined Resource constraints.

Scheduled times are also used to produce reports which show the expected
workload for any given day.

1.2.7 Control of Printed Reports
When a batch job is defined in JAMS you can specify the reports which the
job produces along with the printer queue they should be printed on and
the number of copies and form to be printed on. This lets the Operations
group control the printing of reports without changing any DCL command
files. When a job is requested, a user is able to override the default print
specifications for each report.

Note: This capability requires that you use the command file template
expansion option when setting up jobs. Command file template
expansion is explained in the JAMS Reference Manual.
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2 Getting Started with JAMS

This chapter provides a step by step guide to getting started with the Job
Access and Management System, also known as JAMS.

2.1 After the Installation
After JAMS has been installed, with no changes to your existing jobs
and no information in the JAMS database, JAMS provides many useful
benefits.

2.1.1 Job Execution History
JAMS monitors all batch jobs on the system, even jobs which were not
submitted by JAMS. You can use the History Inquiry function to review
what jobs have run, their execution statistics and completion status. If
you retain your log files, they will be available for review as well.

2.1.2 Job Failure Alerting
JAMS can alert you when any batch job fails. Simply select the
Configuration option from the Management Options menu and supply
the OpenVMS Usernames and/or operator classes for the people who
should be notified when a job fails. JAMS can notify you of a failed job via
VMSmail, broadcast messages and OPCOM messages.

2.1.3 Job Monitoring and Management
The Monitor Jobs menu option can be used to monitor and manage all
batch jobs on your system. This feature provides a powerful, easy to learn
interface to OpenVMS batch processing.

2.2 Defining and Using JAMS Jobs
JAMS has been designed to be very easy to implement because the
implementation can be done in phases, a Job at a time. JAMS will start
providing useful information within minutes of installation. The benefits
of JAMS will continue to accrue as you implement more jobs.

In order to expand JAMS capabilities, you need to enter information into
the JAMS database. To begin, you need to understand three terms which
are used extensively in JAMS. These terms are System, Job and Setup.

A System is a logical group of jobs. A JAMS System Definition defines
things which are common to all jobs within the System.
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A Job is a command or command procedure. Most sites are already using
command procedures for their batch processing. You can continue to use
your existing command procedures after installing JAMS. In order to take
full advantage of JAMS, you will need to enter information about your
batch jobs into the JAMS database, this is a Job Definition.

A Setup is the definition of a particular occurrence or view of one or more
jobs. Setups are commonly used to schedule a job, or stream of jobs, to
automatically execute at a regular interval.

2.3 Systems Definitions
In JAMS, Job and Setup Definitions must belong to a particular System.
This means that you must create at least one System Definition before you
can create any Job or Setup Definitions.

Let’s create the simplest System possible. We’ll call it the DEMO System.
For these examples we will use the command line interface. Please keep
in mind that you can use this interface or the screen based interface to
define Systems.

The JAMS command would be:

JAMS> DEFINE SYSTEM DEMO
SYSTEM_DEF> END_SYSTEM

That’s simple! This illustrates that, although a JAMS System definition
has many potential attributes, you do not have to define anything which
isn’t useful to your environment.

Note: The previous example showed the results of entering the
commands at the JAMS> prompt. It will be easier to follow along if
you use a text editor to create a JAMS command file. This way, you
won’t have to retype the commands each time we add to them. You
simply edit your command procedure and then execute it from the
JAMS> prompt by typing @filename.ext. From now on, the examples
will show the contents of the command procedure, without the
prompts.

While the DEMO System is simple, it isn’t very useful. Let’s expand the
definition to make it more useful.

DEFINE SYSTEM DEMO
DESCRIPTION "Demo System"
DEFAULT SOURCE LOCATION DEMO$DISK:[DEMO.DCL]
BATCH QUEUE PROD_QUE1
MAIL NOTIFICATION "JOHN"

END_SYSTEM

There, now we have a description of this System, and some defaults which
will make it easier to create job definitions. There are a lot more attributes
which we could specify but, we’ll keep it simple for now.

One thing to note, a System Definition has an Access Control List (ACL)
which controls who may manipulate the jobs in the System. Since we
didn’t specify an ACL in the definition, JAMS provided a default ACL
which grants us complete access. No one else has any access at all.
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2.4 Job Definitions
The most basic Job definition consists of the Job’s name and System
I.D. Entering this information into the JAMS database will provide more
meaningful reporting, because jobs will be grouped by System. The System
definition will also enable a finer degree of control over who should receive
notification of abnormal Job terminations.

Let’s create the simplest Job possible. We’ll call it DEMOJOB1 and make
it a member of the DEMO System. The JAMS command would be:

DEFINE JOB DEMOJOB1
SYSTEM DEMO

END_JOB

While is is extremely simple, it could be a complete job definition because
the System definition provides a lot of default values. If the command
procedure for this job was named DEMOJOB1.COM and was located
in DEMO$DISK:[DEMO.DCL] and it didn’t require any parameters,
this would be a complete definition. We could submit the job with the
command:

JAMS SUBMIT DEMOJOB1

JAMS would prompt for the scheduled date and time and submit
DEMO$DISK:[DEMO.DCL]DEMOJOB1.COM to the PROD_QUE1 batch
queue (which it picked up from the System Definition).

2.4.1 Automatic Job Submission
So far, DEMOJOB1 is simple but, not very useful. The first thing that
most people want to do with JAMS is automate the submission of jobs.
We can manually submit DEMOJOB1, let’s see what we have to do to
automatically submit it.

DEFINE JOB DEMOJOB1
SYSTEM DEMO
AUTO SUBMIT
SCHEDULED DATE "MONDAY, WEDNESDAY, FRIDAY"
SCHEDULED TIME 14:00

END_JOB

Now JAMS will automatically submit DEMOJOB1 every Monday,
Wednesday and Friday at 2:00 PM. One word of caution, JAMS generally
schedules about 24 hours in advance so a new job definition won’t be
automatically scheduled until the day after it’s created.

Notice how the scheduled date is a natural language specification. JAMS
understands almost any date specification including complicated ones
like ‘‘LAST WORKDAY OF MONTH’’, ‘‘2ND TUESDAY OF MONTH’’ or
‘‘FIRST DAY OF NEXT MONTH’’.
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2.4.2 Parameters
Command procedures can be much more powerful if you can pass
parameters to them. Likewise, batch jobs can be more powerful if they
can handle parameters. JAMS has very powerful parameter handling
capabilities. Let’s add some parameters to our demo job.

DEFINE JOB DEMOJOB1
SYSTEM DEMO
AUTO SUBMIT
SCHEDULED DATE "MONDAY, WEDNESDAY, FRIDAY"
SCHEDULED TIME 14:00
PARAMETER P1

PROMPT "Start Date"
DATE
DEFAULT VALUE "FIRST DAY OF MONTH"

END_PARAMETER
PARAMETER P2

PROMPT "Sales Category"
TEXT LENGTH 4
DEFAULT VALUE "ALL"

END_PARAMETER
END_JOB

We’ve added two parameters to DEMOJOB1, P1 is a date parameter and
P2 is a text parameter. Perhaps the DEMOJOB1 job produces a sales
report of sales since the specified date for the specified sales category.
Notice that the default value for the date parameter is a natural language
date specification.

If you used the JAMS SUBMIT command now, JAMS would prompt you
for the values for these parameters using a ‘‘fill in the blanks’’ form.

In this example we used parameter names of P1 and P2 which will be
familiar to DCL programmers. You want to use ‘‘Pn’’ parameter named
for your existing command procedures but, JAMS supports up to 255
parameters per job with names up to 31 characters in length. See the
JAMS Reference Manual for more information on this.

2.4.3 Source Code
A JAMS Job definition can also include the command procedure for
the job. For clarity, the previous examples didn’t include the command
procedure. Here’s an example which includes the source code.
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DEFINE JOB DEMOJOB1
SYSTEM DEMO
AUTO SUBMIT
SCHEDULED DATE "MONDAY, WEDNESDAY, FRIDAY"
SCHEDULED TIME 14:00
PARAMETER P1

PROMPT "Start Date"
DATE
DEFAULT VALUE "FIRST DAY OF MONTH"

END_PARAMETER
PARAMETER P2

PROMPT "Sales Category"
TEXT LENGTH 4
DEFAULT VALUE "ALL"

END_PARAMETER

SOURCE IS
$!
$! The command procedure for the job can be contained
$! in the job definition too!
$!
$ RUN DEMOPROGRAM
$!

END_SOURCE

END_JOB

2.5 Setup Definitions
A JAMS Setup Definition sets up up one or more jobs to run. A Setup
can specify values for parameters, schedules and many other attributes
of a job. In our Job Definition example, the DEMOJOB1 job is going to
automatically run every Monday, Wednesday and Friday to produce a
report for all sales categories of sales since the beginning of the month.
Suppose the manager of the XYZ sales category wants this report weekly
for just the XYZ category. We could create another job which is nearly
identical to DEMOJOB1 but a better approach may be to create a Setup
Definition which runs the DEMOJOB1 job with difference parameters.
Here is that Setup definition:

DEFINE SETUP DEMOJOB1_WEEKLY
SYSTEM DEMO
AUTO SUBMIT
SCHEDULED DATE "FRIDAY"
SCHEDULED TIME 18:00
JOB DEMOJOB1

STEP 1
PARAMETER P1

DEFAULT VALUE "MONDAY"
END_PARAMETER
PARAMETER P2

DEFAULT VALUE "XYZ"
END_PARAMETER

END_JOB
END_SETUP

This setup definition runs the DEMOJOB1 job with a different schedule
and different parameters.
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Setups can contain more than one job. Once the managers of the other
sales categories see how useful this weekly report is, they will want the
same report for their sales category. The setup could wind up looking like
this:

DEFINE SETUP DEMOJOB1_WEEKLY
SYSTEM DEMO
AUTO SUBMIT
SCHEDULED DATE "FRIDAY"
SCHEDULED TIME 18:00
JOB DEMOJOB1

STEP 1
PARAMETER P1

DEFAULT VALUE "MONDAY"
END_PARAMETER
PARAMETER P2

DEFAULT VALUE "XYZ"
END_PARAMETER

END_JOB
JOB DEMOJOB1

STEP 2
PARAMETER P1

DEFAULT VALUE "MONDAY"
END_PARAMETER
PARAMETER P2

DEFAULT VALUE "ABC"
END_PARAMETER

END_JOB
JOB DEMOJOB1

STEP 3
PARAMETER P1

DEFAULT VALUE "MONDAY"
END_PARAMETER
PARAMETER P2

DEFAULT VALUE "DEF"
END_PARAMETER

END_JOB
END_SETUP

Now, the DEMOJOB1_WEEKLY Setup runs the DEMOJOB1 Job three
times with different parameters. Since we specified sequential steps, the
jobs will run one at a time. We could also put more than one job in a step
to run jobs in parallel.

2.6 Sequencing
One of the most important responsibilities of a job scheduling system is to
properly sequence and regulate job execution. It must make sure that a
job’s prerequisites are met before a job is released and it must make sure
that it doesn’t overload the systems with batch processing. JAMS provides
a number of feature in this area.

2.6.1 Setups
A Setup sets up one or more Jobs to run. A Setup is the simplest way to
sequence a stream of Jobs. The Jobs in a Setup run in order based upon
the step which the job is assigned. If more than one Job is assigned the
same step, those Jobs can run in parallel.
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In addition to a step, each Job in the Setup also contains attributes that
define what should happen if the Job fails. These attributes include:

• Minimum acceptable completion severity.

• Should the Setup wait for the completion of this job?

• Should the Setup halt if the job fails?

2.6.2 Dependencies
A Job or Setup can have an unlimited number of dependencies. There are
job completion dependencies and variable dependencies.

2.6.2.1 Job Dependencies
A job completion dependency insures that a prerequisite job has completed
before a job is released. One key question is, completed since when? The
default is since the last time that the depending job completed. You can
change this since job or eliminate the since job and use an absolute time
range.

Let’s add a Job dependency to our demo job (note that this is a partial Job
definition).

DEFINE JOB DEMOJOB1
...

DEPENDS ON
JOB RUN_FIRST

END_DEPEND
...
END_JOB

This dependency will make the DEMOJOB1 job wait if the RUN_FIRST
job hasn’t completed successfully since the last time that DEMOJOB1
completed successfully.

Let’s change this dependency a little.

DEFINE JOB DEMOJOB1
...

DEPENDS ON
JOB RUN_FIRST
SINCE JOB RUN_LAST

END_DEPEND
...
END_JOB

Now this dependency will make the DEMOJOB1 job wait if the RUN_
FIRST job hasn’t completed successfully since the last time that a third
job (RUN_LAST) completed successfully.

We can also eliminate the since job.

2–7



Getting Started with JAMS

DEFINE JOB DEMOJOB1
...

DEPENDS ON
JOB RUN_FIRST
NO SINCE JOB

WITHIN 12 HOURS
END_DEPEND

...
END_JOB

Now this dependency will make the DEMOJOB1 job wait if the RUN_
FIRST job hasn’t completed successfully within the past 12 hours.

2.6.2.2 Variable Dependencies
A JAMS Variable is persistent named piece of data. It has a name,
datatype and current value. JAMS Variable have a number of uses one
of which is being used in a dependency. A Variable dependency is simply
a test of the value of a variable. If the test is true, the dependency is
satisfied.

Let’s add a Variable dependency to our demo job (note that this is a partial
Job definition).

DEFINE JOB DEMOJOB1
...

DEPENDS ON
VARIABLE FREESPACE > 25000

END_DEPEND
...
END_JOB

This dependency looks at the JAMS Variable named FREESPACE. If it’s
value is greater than 25,000 the dependency is satisfied.

2.6.3 Precheck Jobs
A Precheck Job is a user written dependency. When a Job’s dependencies
are satisfied JAMS will submit the Job’s Precheck Job (if it has one), if
the Precheck Job completes successfully JAMS will release the main Job.
If the Precheck fails, the main Job will continue to hold and JAMS will
resubmit the Precheck job after the defined delay.

The Precheck job can also exit with the JAMS_CANCELJOB status which
tells JAMS that the main job doesn’t need to run. JAMS will then process
the main job as if it has just completed and it will be removed from the
schedule. Let’s see what we would add to a Job (or Setup) definition to add
a Precheck Job (note that this is a partial Job definition).

DEFINE JOB DEMOJOB1
...

PRECHECK JOB CHECK_EDI_TRANSMISSION
PRECHECK INTERVAL 00:15

...
END_JOB
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You can see that we only needed to add two lines to the job definition in
order to specify a Precheck Job. The second line is optional, if we had left
it out the interval would default to 5 minutes.

2.6.4 Resources
Resources are a very powerful scheduling tool because they let you define
the requirements for your jobs and then JAMS will figure out which jobs
can run together, how many jobs can run simultaneously etc. In JAMS, a
Resource is created with a command like this:

CREATE RESOURCE SALES_DATABASE/AVAILABLE=100

In this example we’ve created a Resource called SALES_DATABASE
and we specified that we have 100 available. Now we can add Resource
Requirements to System, Job or Setup definitions by simply adding a like
like this:

DEFINE JOB DEMOJOB1
...

REQUIRES SALES_DATABASE QUANTITY 25
...
END_JOB

Now, there must be 25 units of the SALES_DATABASE available or
the DEMOJOB1 will remain pending. You will never have more than 4
occurrences of DEMOJOB1 running concurrently.

Just think of the possibilities, is the SALES_DATABASE resource
represents a database named Sales, a job which requires exclusive access
to the sales database simply has to specify that it requires 100 units
of SALES_DATABASE. If you have a problem with the sales database
you can simply change the quantity available to zero and jobs will stop
running.
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3 Getting Started on Windows NT/2000

This chapter provides a step by step guide to getting started running
JAMS jobs on Microsoft Windows NT/2000.

3.1 Getting Ready for Windows NT
There are a number of tasks which must be completed before you can run
jobs under Windows NT/2000. These tasks include:

• Install and Configure the JAMS Agent

• Define NT Usernames in JAMS

• Grant ‘‘Log on as a batch job’’ to NT accounts or groups

3.1.1 Install and Configure the JAMS Agent
The JAMS Agent for Windows NT must be installed on any Windows
NT/2000 machine which will run JAMS Jobs. The Agent can be installed
on any class of NT system, from Workstation to Datacenter Server. Refer
to the JAMS Installation Guide for a detailed explanation of the Agent
installation procedure.

Installing the Agent also installs a JAMS Control Panel applet which is
used to configure the Agent. This control panel applet lets you configure
three settings:

Temporary Directory

The temporary directory is used to store temporary command procedures.
These command procedures are deleted when a job completes. For
Windows NT V4.0, the default can be used. For Windows 2000, you
must specify a directory which can be accessed by the JAMS Agent and
the accounts which jobs will run under.

Requester Secret

The Requester Secret is used to authenticate JAMS Servers before they
can even attempt to run a job. The default is blank which disables this
check. If you use requester authentication you must set the same secret
here and on the server. You set the requester secret on the server with the
JAMS SET AGENT/SECRET="secret" command.

TCP/IP Port

The Agent will listen for requests on the TCP/IP port specified. The
default is port 77 which is reserved for private RJE systems. The port on
the agent must match the port on the server. You set the TCP/IP port on
the server with the JAMS SET AGENT/PORT=n command.
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Allow Interactive

If checked, the Agent will allow jobs to run with interactive access
to the desktop. Interactive access must be requested by setting the
INTERACTIVE option in the job’s execution method.

3.1.2 Define NT Usernames in JAMS
In order to run a job under Windows NT, the JAMS server must supply
a valid NT username and password. You must use the SET USERNAME
command to define the username/password combinations. You can also
specify an access control list (ACL) which is used to determine who can
use the username.

Here is an example of an NT user definition:

JAMS> SET USERNAME ADMINISTRATOR/PASSWORD="SecretPassword" -
_JAMS> /ACL=(IDENTIFIER=[1,*],ACCESS=SUBMIT)

This example defines the NT username ‘‘Administrator’’. The password
must be the correct password for the Administrator account but, the
password isn’t checked until a job is run under this username. Note
that the password is enclosed in quotes to preserve the case. The ACL
will allow OpenVMS users that are in the [1,*] UIC group to specify
‘‘Administrator’’ as the username in a job or system definition.

3.1.3 Grant ‘‘Log on as a batch job’’ to NT accounts or groups
JAMS jobs run as batch processes under Windows NT. The NT account
that the batch job will run as must have the ‘‘Log on as a batch job’’ user
right. You can grant this right to specific accounts or, grant the right to a
group and make the accounts members of the group.

3.1.3.1 Granting rights under Windows NT V4.0
Under Windows NT V4.0, you must grant the ‘‘Log on as a batch job’’ right
on each machine which will be running the JAMS Agent. You only have to
grant the right on one domain controller and it will propagate to the other
domain controllers in the domain. It will not propagate to member servers
or workstations, you must grant the right on each of those machines.

You can use User Manager for Domains to grant the right for both the
domain and individual machines. Select the User Rights option from the
Policy menu. You must check the ‘‘Show Advanced User Rights’’ check box
to display the ‘‘Log on as a batch job’’ user right.

To manage user rights on member servers and workstations, select the
Select Domain... option from the User menu. Enter ‘‘\\machinename’’
in the Domain field and click Ok. You will then be connected to the
specified machine and you will be able to manage the user rights on that
machine.
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3.1.3.2 Granting rights under Windows 2000
Under Windows 2000, you can grant the ‘‘Log on as a batch job’’ right at
the domain level or local level.

To manage rights under Windows 2000 you use the ‘‘Local Security Policy’’
or ‘‘Domain Security Policy’’ Administrator Utilities.

3.1.3.3 Granting rights with the NTRights.exe Utility
The NTRights.exe utility is included in the Windows NT Server 4.0
Resource Kit supplement 3 and in the Windows 2000 Resource Kit. If
you have this utility you can grant the ‘‘Log on as a batch job’’ right with a
command like this:

ntrights +r SeBatchLogonRight -u user_or_group -m \\computername

Note that the rights name is case sensitive.

3.2 Creating NT Jobs
Once you’ve completed the initial setup required to run jobs on Windows
NT/2000, defining jobs is simple. There is essentially no difference
between an NT and an OpenVMS job definition. The key differences
are:

• An NT job must use NT commands rather than DCL.

• An NT job must specify an execution method which is designed for NT.

• An NT job should specify an agent node name.

3.2.1 Windows NT Execution Methods
JAMS ships with three Windows NT specific execution methods. You
can create additional execution methods with the CREATE METHOD
command. The three Windows NT execution methods are:

Method Description

NT Runs an NT command file.

NTCMD Runs a single NT command.

NTPARSE Runs an NT command file which has been parsed for
JAMS parameter references.

3.2.2 Windows NT Example Job
Let’s take the DEMOJOB1 from the Chapter 2 and make it into a Windows
NT job.
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DEFINE JOB DEMOJOB1
SYSTEM DEMO
METHOD NTPARSE
AGENT NODE NTNODE.YOURNAME.COM
AUTO SUBMIT
SCHEDULED DATE "MONDAY, WEDNESDAY, FRIDAY"
SCHEDULED TIME 14:00
PARAMETER P1

PROMPT "Start Date"
DATE
DEFAULT VALUE "FIRST DAY OF MONTH"

END_PARAMETER
PARAMETER P2

PROMPT "Sales Category"
TEXT LENGTH 4
DEFAULT VALUE "ALL"

END_PARAMETER
END_JOB

Notice that the only difference between the NT and OpenVMS version of
this job is METHOD and AGENT NODE lines. One other key difference
is the default filename. The execution method defines the default file
extension so the OpenVMS version would use a default filename of
DEMOJOB1.COM and the NT version would use a default filename of
DEMOJOB1.CMD. Both versions would look in the directory specified in
the DEMO system definition.
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This chapter provides a step by step guide to getting started running
JAMS jobs on Unix, Linux or any other operating system which supports
rexec.

4.1 Getting Ready for Unix
There are a number of tasks which must be completed before you can run
jobs under Unix. These tasks include:

• Define Unix Usernames in JAMS

• Verify that the rexec daemon is enabled on your target machines.

4.1.1 Define Unix Usernames in JAMS
In order to run a job via Rexec, the JAMS server must supply a valid
username and password. You must use the SET USERNAME command
to define the username/password combinations. You can also specify an
access control list (ACL) which is used to determine who can use the
username.

Here is an example of a user definition:

JAMS> SET USERNAME "Ritchie"/PASSWORD="SecretPassword" -
_JAMS> /ACL=(IDENTIFIER=[1,*],ACCESS=SUBMIT)

This example defines the username ‘‘RITCHIE’’. The password must be the
correct password for the RITCHIE account but, the password isn’t checked
until a job is run under this username. Note that both the username and
password are enclosed in quotes to preserve the case. The ACL will allow
OpenVMS users that are in the [1,*] UIC group to specify ‘‘Ritchie’’ as the
username in a job or system definition.

4.1.2 Verify that the rexec daemon is enabled on your target
To verify that the rexec daemon is enabled and working on your target
machine, enter and rexec command from the OpenVMS machine which
is running JAMS. The exact format of the rexec command may differ
depending upon which TCP/IP package you have installed. For Compaq
TCP/IP Services a test command would be similar to this:

$ rsh/user=unixuser/password=password unixhost ls
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4.2 Creating Unix Jobs
Once you’ve completed the initial setup required to run jobs via rexec,
defining jobs is simple. There is essentially no difference between an rexec
and an OpenVMS job definition. The key differences are:

• An rexec job must use the target environment commands rather than
DCL.

• An rexec job must specify an execution method which is designed for
rexec jobs.

• An rexec job should specify an agent node name.

4.2.1 Rexec Execution Methods
JAMS ships with an execution method named rexec which is designed for
single command jobs and an execution method named rexec_script which
sends a parsed command procedure to an rexec server. You can create
additional execution methods with the CREATE METHOD command.

4.2.2 Rexec Example Job
Let’s take the DEMOJOB1 from the Chapter 2 and make it into an rexec
job.

DEFINE JOB DEMOREXEC
SYSTEM DEMO
METHOD REXEC
AGENT NODE UNIXNODE.YOURNAME.COM
AUTO SUBMIT
SCHEDULED DATE "MONDAY, WEDNESDAY, FRIDAY"
SCHEDULED TIME 14:00
COMMAND "perl knit2.pl"

END_JOB
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5 Using JAMS_MASTER

This chapter describes the JAMS_MASTER program. JAMS_MASTER
is the OpenVMS command line and screen based user interface to JAMS.
This program is used to define jobs and their environment, submit jobs,
and to monitor and control the JAMS system processes.

Many of the functions of JAMS_MASTER are also available with both
the DECwindows/Motif and Windows 9x/NT/2000 interfaces. Refer to
Chapter 8 for more information on the DECwindows/Motif interface. Refer
to Chapter 7 for more information on the Windows interface.

5.1 JAMS_MASTER
To enter the JAMS Master environment, run the JAMS_MASTER.EXE
executable image which is located in the directory pointed to by the
JAMS_EXE logical name. The system responds with a brief introductory
message and the JAMS> prompt as shown in the following example:

$ RUN JAMS_EXE:JAMS_MASTER Return

JAMS V4.0N
Copyright (c) 1991 - 2002 MVP Systems, Inc., All rights reserved.
For technical support call (866) 259-JAMS 24 hours a day, 7 days a week.
JAMS>

5.1.1 Foreign Command Lines
The JAMS_MASTER.EXE executable also supports foreign command
lines. You can create a DCL symbol which invokes JAMS_MASTER.EXE
and then specify a command on the same line as the symbol, as shown in
the following example:

$ JAMS:==$JAMS_EXE:JAMS_MASTER Return

$ JAMS MENU Return

You can also define DCL symbols which will both invoke JAMS_MASTER
and pass a command line to be processed. The following example defines a
symbol which can be used to immediately display a specific job submission
menu.

$ PAYJOBS:==$JAMS_EXE:JAMS_MASTER MENU/OPTION=SUBMIT/MENU=PAYROLL Return

5.2 Customizing JAMS_MASTER
Some areas and features of the JAMS_MASTER can be customized. This
customization is controlled with logical names. These logicals may be
defined system-wide or, on a per process basis.
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5.2.1 Remote Connections
You can define the logical name JAMS_REMOTE_CONNECTIONS to be a
list of remote node specifications JAMS will connect to when you use the
MENU command to enter the screen based environment. The remote node
specifications should be in the standard DECnet format as in the following
example:

$ DEFINE JAMS_REMOTE_CONNECTIONS GRAPE, TRAFIC"MYPROXY"

In this example, when the MENU command is issued connections will be
established to the remote node GRAPE using the current users default
DECnet proxy and to the remote node TRAFIC using the MYPROXY
username/proxy.

5.2.2 Title
The screen based environment displays a title at the top of every
screen. You can customize this title by defining the logical name
JAMS_HEADING, as in the following example:

$ DEFINE JAMS_HEADING "Joe’s Ambulance and Medical Supplies"

5.2.3 Default Job Submission Menu
You can use the logical name JAMS_DEFAULT_MENU to define the
JAMS Menu Name which should be used when a user selects the Job
Submission menu option. If this logical name is undefined, or incorrectly
defined, a System based menu will be displayed.

5.2.4 Messages
JAMS uses standard OpenVMS messages. A OpenVMS message consists
of a facility, a severity, an identifier and the text of the message. When
JAMS sends a message to the screen, it may include any of these
components. You can define which of the message components should
be displayed by defining the logical name JAMS_MESSAGE_FLAGS. This
logical name must equate to an integer which is the sum of one or more
of the following numbers. Including a number in the sum means that the
indicated portion of the message should be sent to the user.

Number Description

1 Include the text of the message.

2 Include the identifier of the message.

4 Include the severity of the message.

8 Include the facility of the message.

If this logical name is not defined, or defined incorrectly, the default
is determined by the processes message flags which are set with the
OpenVMS SET MESSAGE command.
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5.2.5 Date and Time Format
The input and output format of dates and times can be customized on a
per user basis. This customization does not affect how JAMS stores dates
and times. It also does not affect how dates and times are passed to batch
jobs. It only affects what you see and enter on the screen.

To customize dates and times, define one or more of the following logical
names:

Logical Name Default Description

JAMS_DATE_ORDER MDY Defines the order of a dates fields,
possible values are MDY, DMY or
YMD.

JAMS_DATE_DELIMITER / Defines the character used to delimit a
dates fields.

JAMS_TIME_FORMAT 12 Specifies whether you want 12 or 24
hour format, possible values are 12
and 24.

JAMS_HOURS_DELIMITER : The character used to delimit the hours
field.

JAMS_MINUTES_DELIMITER : The character used to delimit the
minutes field.

JAMS_SECONDS_DELIMITER space The character used to delimit the
seconds field.

JAMS_CENTURY_YEAR 20 If the year entered is less than or
equal to this number, the century is
2000, otherwise the century is 1900.
Possible values are zero through 99.

JAMS_YEAR_DIGITS 2 Specifies whether you want 2 or 4 digit
years, possible values are 2 and 4.
This only affects the display and entry
of dates. Internally, 4 digit years are
always used.

5.2.6 Monitor Options
The JAMS Monitor Current Jobs menu option is used to monitor the batch
jobs which are running under JAMS. This application has an Options form
which allows you to set job selection criteria and display characteristics.
When you exit from JAMS these options are saved as DCL symbols and
will be re-used if you invoke JAMS_MASTER again. You could also set
these symbols in your LOGIN.COM command file so that they are set
every time you log on. These symbols are:

JAMS_MONITOR_JOB_SELECTION
JAMS_MONITOR_RUN_USER_SELECTION
JAMS_MONITOR_SCROLL
JAMS_MONITOR_SHOW_DEPEND
JAMS_MONITOR_SHOW_HELD
JAMS_MONITOR_SHOW_PENDING
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JAMS_MONITOR_SHOW_RETAINED
JAMS_MONITOR_SHOW_TIMED
JAMS_MONITOR_SORT_STATUS
JAMS_MONITOR_SUBMIT_USER
JAMS_MONITOR_SYSTEM_SELECTION

These symbols correspond to the fields on the Monitor Options screen.

When an executing job is displayed in the Monitor, the jobs execution
statistics are periodically updated. You can define the update interval by
defining the logical name JAMS_STATS_INTERVAL to be the number of
seconds between updates. If this logical name is not defined, it defaults to
10 seconds.
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6 The Screen Based Environment

This chapter provides a description on using the JAMS screen based
environment.

The screen based environment is a menu driven, forms based environment.
From the JAMS> prompt, issue the MENU command to enter the screen
based environment. The screen based environment requires an SMG
compatible terminal. Compaq provides SMG support for the VTxxx series
terminals.

The screen based environment provides a robust, easy to learn user
interface. This section explains how to use the screen based environment
and explains the features which are common to all of the applications
available within JAMS Maintenance.

6.1 The Main Menu
The screen displayed upon entry to the screen based environment is the
Main Menu. You can return to this menu from any data entry screen by
pressing Gold/M . This will abort any changes which are in progress and
return to the Main Menu.

The Main Menu is show in Figure 6–1. The selections available from the
main menu are explained in the following sections.

6.1.1 History Inquiry
The History Inquiry menu option is used to view information on batch

jobs which are pending, executing or have completed.

When you initially enter the History Inquiry application, you are presented
with a data entry screen which is used to enter you search criteria. You
can also use the Gold/C function key to establish a connection with a
remote node, disconnect an already established connection or switch to an
existing connection.

Once you have entered your selection criteria and pressed Return , JAMS
will search for job execution history which matches your selection criteria
and, if any records are found, display a summary list of the history. You
can move through the list to view this summary information. Figure 6–2
is an example of the History List Screen.
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Figure 6–1 Main Menu

If you want to see detailed information for a specific history line, move
the cursor to the desired line and press the Select key. A detail history
form will be displayed which shows all of the information which JAMS
maintains for a Job.

While viewing history detail, you can press Prev Screen to see the previous
history record in the list or press Next Screen to see the next record in the
list. From the History Detail Screen, press any key to return to the history
list.

If a Job’s .LOG file is available, the Gold/L will be activated and shown in
the function key legend. You can press Gold/L to view the Job’s .LOG file.

Figure 6–3 is an example of the History Detail Screen.

The JAMS history is purged by the JAMS_PURGE Job. The length of
time that history is retained is one of the parameters to this job and is
user defined.

The selection criteria consists of the following fields:
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Figure 6–2 History List Screen

System I.D.

If you enter a value in the System I.D. field, only history from Jobs in the
indicated System is displayed. Leave this field blank to display history
from Jobs in all Systems and from unregistered Jobs.

Job Name

The Job Name search key uses standard OpenVMS wildcards. Leaving the
field blank is the same as specifying *.

Setup Name

The Setup Name search key uses standard OpenVMS wildcards. Leaving
the field blank is the same as specifying *.

Starting and Ending Dates

Only jobs submitted between these two dates will be displayed.

Clear List First

If your enter a ‘‘Y’’ in this field, the current History list will be cleared
before the new search begins. If you enter ‘‘N’’, data from the new search
will be merged with the current list.

Include Jobs with a final severity of

These fields allow you to select History based upon the severity of the Jobs
final status.
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Figure 6–3 History Detail Screen

6.1.2 Definitions
The Definitions option pops up a sub-menu with the following options
available:

6.1.2.1 Setup Definitions
The Setup Definitions option is used to maintain Setup definitions. This
is a standard maintenance function. Working with standard maintenance
functions is explained in Section 6.2.9.

For a complete description of the attributes of a Setup definition, refer to
the JAMS Reference Manual.

6.1.2.2 Job Definitions
The Job Definitions option is used to maintain Job definitions. This is
a standard maintenance function. Working with standard maintenance
functions is explained in Section 6.2.9.

For a complete description of the attributes of a Job definition, refer to the
JAMS Reference Manual.
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6.1.2.3 System Definitions
The System Definitions option is used to maintain System definitions. This
is a standard maintenance function. Working with standard maintenance
functions is explained in Section 6.2.9.

For a complete description of the attributes of a System definition, refer to
the JAMS Reference Manual.

6.1.2.4 Trigger Definitions
The Trigger Definitions option is used to maintain Trigger definitions. This
is a standard maintenance function. Working with standard maintenance
functions is explained in Section 6.2.9.

For a complete description of the attributes of a Trigger definition, refer to
the JAMS Reference Manual.

6.1.2.5 Variable Definitions
The Variable Definitions option is used to maintain Variable definitions.
This is a standard maintenance function. Working with standard
maintenance functions is explained in Section 6.2.9.

For a complete description of the attributes of a Variable definition, refer
to the JAMS Reference Manual.

6.1.2.6 Menu Definitions
The Menu Definitions option is used to maintain Menu definitions. This
is a standard maintenance function. Working with standard maintenance
functions is explained in Section 6.2.9.

For a complete description of the attributes of a Menu definition, refer to
the JAMS Reference Manual.

6.1.3 Job Submission
The Job Submission option is used to submit a Job or Setup. A Job
Submission menu is displayed which could contain Jobs, Setups, Systems
or additional Menus. The initial menu is determined by the /MENU
qualifier or the JAMS_DEFAULT_MENU logical name. For additional
information, refer to the JAMS Reference Manual

For a complete description of submitting a JAMS Job, refer to Chapter 9.

6.1.4 Show Current Jobs
This option displays a list of the currently scheduled Jobs which are
known to JAMS. The functionality of this option has been superseded by
the Monitor Current Jobs option.
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6.1.5 Monitor Current Jobs
Displays a list of current Jobs known to the JAMS Scheduling sub-

system. This list is continuously updated. This display also provides
comprehensive job management capabilities.

Note: This monitor is a high performance batch job monitor. It does not
scan the OpenVMS batch queues to obtain its information. The
JAMS_SCHEDULE process broadcasts messages to the monitors
when events occur. Running the JAMS monitor will not affect the
performance of the OpenVMS batch and print queue sub-system.

Figure 6–4 Monitor Jobs Display

Figure 6–4 is an example of the Monitor screen display. This example
shows a number of batch jobs which are in various states. The first job
is a registered job which is executing. If a job is executing, performance
information is included in the display. If the job is not executing, the
performance information is replaced by a text message which indicates the
current status of the job. When a job completes, the text message indicates
the final status of the job.

The display includes the following information about this job:
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Entry

This is the JAMS entry number for the job.

Job Name

This is the name of the job as specified in the JAMS Job definition.

Node

This is the name of the node on which this job is running.

CPU %

This column shows the CPU utilization percentage for this job during the
most recent update interval.

DIO/s

This column shows the average number of direct I/Os per second which
this job performed during the most recent update interval.

Completion %

If this job is registered in the JAMS database, we can compute the
completion percent based on the Job’s past performance. This percentage
is an estimate of how close to completion the Job is. This can be a useful
monitoring tool. If an operator sees a Job which shows a completion
percentage of 200%, they know that the Job has used twice the resources
which it normally takes and they may want to take corrective action.

This percentage is calculated using the Jobs current and average CPU
usage and Direct I/O count so running the a Job on a heavily loaded
system will not affect this calculation.

Completion Time

If this Job is registered in the JAMS database, we can calculate how much
longer the Job is going to run based on the Job’s past performance. This
calculation is based on the Job’s current CPU utilization and direct I/O per
second count. We extrapolate this data to determine how much longer the
job will run before reaching its average CPU usage and direct I/O count.

Elapsed Time

This shows how long the Job has been executing, in hours and minutes.

CPU Time

This shows how much CPU time the Job has accumulated, in hours and
minutes.

DIO Count

This shows the number of direct I/O operations performed by the Job.
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Job Status Line

The display may also include a line which shows a Job’s status
information. A batch job may use the JAMS SET STATUS/MONITOR
command to set it’s status text. If the /MONITOR qualifier is used then
the status text will be displayed in the Monitor window.

Function Keys

Gold/C - Connections

The Gold/C key is used to establish a connection with a remote node,
disconnect an already established connection or switch to an existing
connection.

Gold/O - Options

The Gold/O key is used to display and modify the Monitor Options. When
you press the Gold/O key, updating stops and the Monitor Options screen
is displayed as shown in Figure 6–5.

Gold/N

The Gold/N key is used to switch to the next connection.

Select - Job Management Menu

The Select key is used to select a job and pop-up the Job Management
Menu. Use the Next Screen , Prev Screen , and arrow keys to move the
cursor to the desired job then press the Select key. The selected job will
be highlighted and the Job Management Menu will pop up as shown in
Figure 6–6.

6.1.5.1 Monitor Options
The Monitor options screen is used to set the characteristics of your
monitoring session. You can set job selection criteria, sorting and scrolling
options. You can also limit the display to only jobs submitted by your
username. The Monitor Options screen is shown in Figure 6–5.

Option Fields

Job Name

You can enter a standard OpenVMS wildcard expression here and only
Jobs which match the wildcard expression will be shown.

System I.D.

You can enter a standard OpenVMS wildcard expression here and only
Jobs whose System I.D. match the wildcard expression will be shown.

Submit User Name

You can enter a standard OpenVMS wildcard expression here and only
Jobs which were submitted by a user with an OpenVMS username which
matches the wildcard expression will be shown.
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Figure 6–5 Monitor Options

Execution User Name

You can enter a standard OpenVMS wildcard expression here and only
Jobs which will execute with an OpenVMS username which matches the
wildcard expression will be shown.

Show pending jobs ?

If you enter a Y, jobs which are pending will be included in the monitor
display.

Show jobs waiting for dependencies ?

If you enter a Y, jobs which are pending because they are waiting for
dependent jobs to complete will be included in the monitor display.

Show held jobs ?

If you enter a Y, jobs which are holding until explicitly released will be
included in the monitor display.

Show timed release jobs ?

If you enter a Y, jobs which are waiting until a specific date and time will
be included in the monitor display.

Show completed/retained jobs ?

If you enter a Y, jobs which have been retained in the batch queue after
completion will be included in the monitor display.
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Scroll continuously ?

If you enter a Y, when the monitor has more jobs to display than can fit
on the screen, the job list will continuously scroll so that all jobs can be
displayed.

Sort by Job Status/Schedule time (or Job Name)

If you enter a N here, the Jobs are sorted by Job Name.

If you enter a Y here, the Jobs will be sorted by status and scheduled
date/time. The order is as follows:

1 Executing and completed jobs, by Job Name.

2 Pending jobs, by priority.

3 Jobs waiting for Pre-check jobs.

4 Jobs waiting for dependencies.

5 Jobs which are held.

6 Jobs waiting for a specific date/time (in order by date/time).

7 Jobs which are retained in a queue.

6.1.5.2 Job Management Menu
The Job Management Menu is used to manage jobs which are executing
or pending. A pending job must be known to JAMS before it will display
in the Monitor window. Please refer to the the JAMS Reference Manual
section in Chapter 5 for information on when and how a job becomes
known to JAMS.

To use the pop up Job Management menu, use the Next Screen ,
Prev Screen , and arrow keys to move the cursor to the desired job then

press the Select key. The selected job will be highlighted and the Job
Management Menu will pop up as shown in Figure 6–6.

You must be properly authorized to use many of the functions available on
the Job Management menu. Authorization is defined by the MONITOR
ACL, the Job’s ACL and the System’s ACL.

Job Management Menu Options

Show Detail

This option will display detailed information about the selected job.
Figure 6–7 is an example of this display. If the job is executing, the
performance information is updated every five seconds. If the job is not
executing, the performance information is replaced by a list of dependent
jobs which this job is waiting on, if any.
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Figure 6–6 Job Management Pop-up Menu

Release

Jobs can be in a pending or holding state for many different reasons.
When you elect to release a job, a form will appear showing all the reasons
this particular job is not running. You can then decide to remove some or
all of the constraints which are keeping the job from executing.

Hold

The selected job is held until released.

Reschedule

This option is used to change the scheduling attributes of a job which is
not executing. A screen is displayed which allows you to change the job
attributes.

Restart

This option is used to abort and restart an executing job. A screen is
displayed which allows you to enter where the job should execute as well
as the hold status. If you exit from this screen, no action is taken. If you
complete the form and press Return , the job is aborted and either restarted
or placed on hold.

Abort/Delete

If the selected job is currently executing it is aborted. Otherwise the job is
deleted from the schedule.
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Figure 6–7 Job Detail

6.1.6 Management Functions
The Management Functions option pops up a sub-menu with the following
options available:

6.1.6.1 Named Times
The Named Times option is used to maintain Named Times. This is a
standard maintenance function. Working with standard maintenance
functions is explained in Section 6.2.9.

For a complete description of the attributes of a Named Time definition,
refer to the JAMS Reference Manual.

6.1.6.2 Dates
The Dates option is used to maintain special Date definitions. This is
a standard maintenance function. Working with standard maintenance
functions is explained in Section 6.2.9.

For a complete description of special Dates definition, refer to the JAMS
Reference Manual.
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6.1.6.3 Access Control
The Access Control option is used to maintain Access Control Lists
for many of the JAMS functions. A menu is displayed which lists the
available Access Control Lists. Once you select an ACL to modify, the ACL
is displayed in a list and you can select a specific Access Control Entry
(ACE) to modify or insert or delete ACE’s.

For a complete description of each of the ACL’s and the rights available,
refer to the JAMS Reference Manual.

6.1.6.4 Node Definitions
The Node Definitions option is used to maintain Node definitions. This is
a standard maintenance function. Working with standard maintenance
functions is explained in Section 6.2.9.

For a complete description of the attributes of a Node definition, refer to
the JAMS Reference Manual.

6.1.6.5 Node Groups
The Node Groups option is used to maintain Node Group definitions. This
is a standard maintenance function. Working with standard maintenance
functions is explained in Section 6.2.9.

For a complete description of the attributes of a Node Group definition,
refer to the JAMS Reference Manual.

6.1.6.6 Configuration
The Configuration option will display a data entry screen which contains
all of the JAMS configuration attributes. For a complete description of all
of the configuration attributes, refer to the JAMS Reference Manual.

6.1.6.7 Date Types
The Date Types option is used to maintain Date Type definitions. This is
a standard maintenance function. Working with standard maintenance
functions is explained in Section 6.2.9.

For a complete description of the attributes of a Date Type definition, refer
to the JAMS Reference Manual.

6.2 Common Functions and Features
The JAMS screen based user interface provides a common interface to
each function. Once you learn to use one function learning to use the next
one is simpler because the interface is the same. The following sections
describe the common features and functions of the screen based interface.

6.2.1 On-line Help
The JAMS screen based environment provides extensive on-line help. You
access the on-line help by pressing the Help or PF2 key.
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The JAMS full screen help utility is similar to the standard OpenVMS
Help utility. When you press the Help key, help text will be displayed for
the current menu or field. You can use the Next Screen and Prev Screen

keys to scroll the help text.

If there are additional topics available, there will be a box menu below
the help text which is used to select one of the additional topics. Use the
arrow keys to change the highlighted topic and press Return to display the
selected topics help text.

Press the Exit key to exit help and return to the application.

6.2.2 Menus
Menus are used in many places in the JAMS Maintenance sub-system.
Menus are presented in the center of the screen as a vertical list of
options surrounded by a bounding box. The currently selected option is
highlighted with reverse video.

Use the arrow keys, space bar, Tab and Ctrl/H keys to move the highlighted
option. Press Return to Select the highlighted option. You can exit a menu
by pressing the Exit key (F10).

You can also select a menu option directly by pressing the highlighted
letter of the menu option. The highlighted letter is underlined.

6.2.3 Insert/Overstrike
When the cursor is in a field, you can press Ctrl/A to toggle between insert
mode and overstrike mode. Insert mode does not work in date and time
fields.

6.2.4 Moving Between Fields
When the cursor is in a data entry screen, you can move to the next field
by pressing the Tab or down arrow key. You can move to the previous field
by pressing the up arrow key, or Ctrl/H (backspace).

6.2.5 Exit Key
The Exit (F10) key is used to go back one logical level. The PF4 can also be
used in place of the Exit key. You can also use the Ctrl/Z key to exit back
to the DCL level.

The Exit and Ctrl/Z keys will abort any changes which are in progress.
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6.2.6 Find Key
Many fields (including most key fields) have search capabilities. When the
cursor is in a field with search capabilities, ‘‘Find’’ will be displayed in the
Function Key Label. You can press the Find key and a search list will be
displayed. If the field has a limited number of values, the possible values
are displayed in a list, and you can select the desired value.

If the field could have many different values, such as a Job Name, the
list will have one or more search keys at the top of the list. You can enter
information into these fields to narrow the search then press Return to
start searching. The list of data records found is displayed in the bottom
portion of the list, and you can select one of the values.

6.2.7 List Screens
List screens are similar to menus. A vertical list of available options is
displayed and you can use the arrow keys to move the cursor through the
list. A list may also be larger than the available screen size. In this case,
the data will scroll within the list window. You can use the Next Screen

and Prev Screen keys to scroll by pages. You can also press Gold/Up Arrow

to move to the first item in the list or Gold/Down Arrow to move to the last
item in the list. To select an item in the list, move the cursor to the line
which contains the item you want to select and then press Return .

6.2.8 Screen Layout
A Sample JAMS Screen is shown in Figure 6–8. The top three lines of the
screen display status information. The first line contains the current date,
the sub-system title and version information. The second line contains a
title bar which consists of a numeric screen identifier and a description
or heading. If this is a maintenance function, the third line is used for a
horizontal strip menu used to select and display the maintenance mode.

The bottom three lines are used to display active function key information
and to display messages. Messages are displayed on the last line. The
reverse video line is broken into a number of sections. Each section can
contain the name of an active function key, the Function Key Label.
Directly below the name of the key is an indicator of what should happen
when you press the function key, the Function Key Action.

6.2.9 Maintenance Functions
Many of the options available from the JAMS Main Menu are maintenance
functions. Maintenance functions are used to add, change, delete and
inquire into definitions of JAMS objects such as Jobs or Setups. The
following sections explain how to use a JAMS maintenance function.
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Figure 6–8 Sample JAMS Screen

Function Key AcFunction Key Label

Maintenance Mode Indicator Title Bar Key Field

Options Sub−Menu

6.2.9.1 Maintenance Mode Menu/Indicator
Most of the maintenance screens available to you have multiple modes.
For example, if you select Job Definitions after selecting Definitions from
the Main Menu, the Job Definitions maintenance screen is displayed and
the Maintenance Mode Menu is displayed on the third line of the terminal.
The current mode is highlighted with reverse video. Use the arrow keys
(or Tab and Ctrl/H ) to change the highlighted mode and press Return when
the mode you desire is highlighted.

You can also enter the first letter of the desired mode to select a
maintenance mode.

The possible options available on the Maintenance Mode Menu are:

Show - Display data with no update capabilities.
Modify - Modify existing data records.
Add - Add new data records.
Copy - Copy an existing record to a new record.
Delete - Delete existing data records.

If the JAMS Access Control has been used to limit access, only the
options which are currently available to you are displayed. If there is
only one option available, it is automatically selected and you skip over
the Maintenance Mode Menu.
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6.2.9.2 Key Fields
Once you have selected an option from the Main Menu and selected a
Maintenance Mode (if needed), the cursor moves into the data entry
portion of the screen. The first step is to select a data record to process.
You select a record by entering a value into one or more key fields. These
fields are highlighted with reverse video and are the only fields the cursor
will move to.

After you have entered the key fields, press Return , and the specified data
will be retrieved, displayed, and the cursor will move into the first data
field.

If the data could not be located or you selected Add mode and the data
could be located, an appropriate message is displayed and the cursor
remains in the key field(s).

Remember that you can use the Find key if you do not remember (or want
to type) the key field information.

6.2.9.3 Data Entry Screens
One you have selected an object you are presented with either a data entry
screen or a menu of options. Simple objects, like a Variable Definition,
present a data entry screen which contains all of the attributes of the
object. Complex objects, like a Job Definition, present a menu of options.
When you select one of the options you are presented with a data entry
screen which contains the attributes which pertain to the selected option.
Some of the options may present a list screen when the option may have
multiple occurrences. An example of this would be the parameters for
a Job Definition. Since a Job may have many parameters, when you
select the Parameters option you are presented with a list of the Jobs
Parameters. When you select a parameter (or insert a new one) you
are presented with a data entry screen which has the attributes for the
selected parameter.

6.2.9.4 Special Function Keys
Some of the maintenance functions also have special function keys. If a
special function key is used, it will be shown in the function key legend at
the bottom of the screen. An example of this would be Trigger Definitions.
When you select a Trigger, the Triggers information is displayed in a data
entry screen but you also have two special function keys. One to display
the Triggers Events and one to display the Triggers Actions.

6–17





7 JAMS Windows Interface

This chapter describes the JAMS Windows 9x/NT/2000 Interface. You
can submit, monitor, and view the history of job execution using this
interface.

7.1 Starting the JAMS Windows 9x/NT/2000 Interface
When JAMS is installed, JAMS is added to the Programs section of
the Start Menu. To start the interface, select JAMS from the Programs
section of the Start Menu.

If the JAMS menu item does not appear in your Start Menu, you can
search for the file ‘‘JAMSWin.exe’’ on your local disk drives. If you find the
file, double-click it to start the interface. You may also want to create a
short-cut to this program to make it easily available for the future.

When JAMS starts, you will be presented with a JAMS Server Login
dialog box. Here you must specify the remote server you would like to
connect to along with your username and password for authentication.
At the time of login, you can also specify if you would like for JAMS to
remember this information the next time you run the JAMS Windows
interface.

7.2 Submit Window
The Submit Window is used to select and submit JAMS Jobs which
are run on demand. The window consists of a default or user defined
menu hierarchy. The default hierarchy shows all of the JAMS Systems,
expanding a System displays all of the Jobs and Setups for the selected
System.

If you want to specify a user defined menu, define the logical name JAMS_
DEFAULT_MENU to be the name of the menu which you want to use as
the top level menu.

Figure 7–1 is an example of the Submit Window.

7.2.1 Navigating the Window
The Submit Window displays a menu hierarchy. A sub-menu is denoted
with a triangle to the left of the menu name. If the triangle points to the
right, the menu is not expanded. If the triangle points down, the menu is
expanded. To expand a menu, you can double click on the menu or, click
on the menu (to select it) and then pull down the Action menu and select
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Figure 7–1 Windows Submit Window

Expand. You can also right-click while the cursor is on the menu you
want to expand and then select Expand from the pop-up menu.

You can submit a Job or Setup by double clicking on the Job or Setup. You
can also select Submit from the pull-down or pop-up menu.

You can activate the JAMS History window and display a Jobs history by
selecting Show History from a pull-down or pop-up menu.

7.2.2 File menu
The File pull-down menu is used to control the Submit window.

Connect...

This menu option activates a dialog box which allows you to connect to
a remote JAMS Server. Once connected, you can submit Jobs on that
server.

Disconnect

This menu option lets you disconnect from one of the remote JAMS
Servers which you are connected to.

Close

This menu option will close the Submit window.
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Exit

This menu option will close all of the JAMS windows and exit.

7.2.3 Action menu
The Action menu is used to perform an action on the Submit window or
the selected line in the Submit window. The items in the Action menu are
also available from a pop-up menu. Right-click any menu, Job or Setup to
display the pop-up menu. The options on the Action menu include:

Expand

This option will expand the selected line. This option is only active when
the selected line is a menu line.

You can also expand or collapse a menu by double clicking on the menu
line.

Collapse

This option will collapse the selected menu line. This option is only active
when the selected line is a menu line.

You can also expand or collapse a menu by double clicking on the menu
line.

Collapse All

This option will collapse all expanded menus.

Show History

This option activates the JAMS History Window, clears the current history
list and performs a search for history of the selected Job.

Submit

This option will submit the selected Job or Setup. A dialog box which
contains the jobs parameters will be displayed. If the Job has defined
reports, you can click on the Reports tab to display and possibly override
the report printing information.

7.2.4 Window menu
The Window menu is used to activate other portions of the JAMS
Windows interface. From the Submit window, you can activate the History
window or the Monitor window.

7.3 Submitting a Job
When you submit a job, a dialog box which contains the jobs parameters
will be displayed. If the Job has defined reports, you can click on
the Reports tab to display and possibly override the report printing
information.
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7.4 Monitor Window
The Monitor Window is used to monitor and manage the batch jobs
running on your system. The JAMS Job Monitor is a high performance,
continuously updated display of the batch jobs known to JAMS. This
display also provides comprehensive job management capabilities.

Note: This monitor is a high performance batch job monitor. It does
not scan the operating system’s batch sub-system to obtain its
information. The JAMS_SCHEDULE process broadcasts messages
to the monitors when events occur. Running the JAMS monitor
will not affect the performance of the batch sub-system.

7.4.1 The Monitor Display
The Monitor Window includes two types of display lines, top level
categories and Jobs. A top level category line includes an icon which
shows whether or not the line is expanded, the number of jobs in the
category, the name of the category and detail headings. You can expand or
collapse a category line by double clicking on the line.

Figure 7–2 is an example of the Monitor Window.

Figure 7–2 Windows Monitor Window
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7.4.2 Monitor Detail Lines
When a Job is executing, the Monitor includes the following information:

Job Name

This is the name of the job as specified in the JAMS Job definition.

Entry

This is the JAMS entry number for the job.

Node

This is the name of the node on which this job is running.

CPU %

This column shows the CPU utilization percentage for this job during the
most recent update interval.

DIO/s

This column shows the average number of direct I/O’s per second which
this job performed during the most recent update interval.

Completion %

If this job is registered in the JAMS database, we can compute the
completion percent based on the Job’s past performance. This percentage
is an estimate of how close to completion the Job is. This can be a useful
monitoring tool. If an operator sees a Job which shows a completion
percentage of 200%, they know that the Job has used twice the resources
which it normally takes and they may want to take corrective action.

This percentage is calculated using the Jobs current and average CPU
usage and Direct I/O count so running the a Job on a heavily loaded
system will not affect this calculation.

Completion Time

If this Job is registered in the JAMS database, we can calculate how much
longer the Job is going to run based on the Job’s past performance. This
calculation is based on the Job’s current CPU utilization and direct I/O per
second count. We extrapolate this data to determine how much longer the
job will run before reaching its average CPU usage and direct I/O count.

Elapsed Time

This shows how long the Job has been executing, in hours and minutes.

CPU Time

This shows how much CPU time the Job has accumulated, in hours and
minutes.

DIO Count

This shows the number of direct I/O operations performed by the Job.
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7.4.3 File menu
The File pull-down menu is used to control the Monitor window.

Connect...

This menu option activates a dialog box which allows you to connect to
a remote JAMS Server. Once connected, you can monitor Jobs on that
server.

Disconnect

This menu option lets you disconnect from one of the remote JAMS
Servers which you are connected to.

Close

This menu option will close the Monitor window.

Exit

This menu option will close all of the JAMS windows and exit.

7.4.4 Action menu
The Action menu is used to perform an action on the Monitor window or
the selected line in the Monitor window. The items in the Action menu
are also available from a pop-up menu. Right-click a Job in the Monitor to
display the pop-up menu. The options on the Action menu include:

Expand

This option will expand the selected line. All current and future jobs
in this category will be displayed. This option is only active when the
selected line is a top level line.

You can also expand or collapse a category by double clicking on the
category line.

Collapse

This option will collapse the selected line. The jobs in this category will no
longer be displayed. This option is only active when the selected line is a
top level line.

You can also expand or collapse a category by double clicking on the
category line.

Collapse All

This option will collapse all of the top level categories.

You can also expand or collapse a category by double clicking on the
category line.
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Show Detail

This option will display a window which shows detailed information about
the selected Job. This information will be updated as the Job executes.

You can also display a Job’s detail window by double clicking on the Job.

Show History

This option activates the JAMS History Window, clears the current history
list and performs a search for history of the selected Job.

Release

Jobs can be in a pending or holding state for many different reasons.
When you elect to release a job, a window will appear showing all the
reasons this particular job is not running. You can then decide to remove
some, or all of the constraints which are keeping the job from executing.

Hold

The selected job is held until released.

Reschedule

This option is used to change the scheduling attributes of a job which is
still pending. A screen is displayed which allows you to enter a new queue
name, scheduled date/time and hold status.

Restart

This option is used to abort and restart an executing job. A window is
displayed which allows you to enter a new queue name and hold status. If
you complete the form and click on the Ok button, the job is aborted and
requeued.

Abort/Delete

If the selected job is currently executing, it is aborted and deleted from
the batch sub-system. Otherwise the job is simply deleted from the batch
sub-system. You are asked to confirm this action.

7.4.5 Window menu
The Window menu is used to activate other portions of the JAMS
Windows interface. From the Monitor window, you can activate the
Submit window, or the History window.

7.5 History Window
The History Window is used to search and examine batch job execution
history.

Figure 7–3 is an example of the History Window.
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Figure 7–3 Windows History Window

7.5.1 The History Display
The History display window contains one line for each history record
which matched your selection criteria. Each line shows the Job Name,
final status and, submit, start and completion time. You can double click
on a line to display a detail window.

You can sort the list by any column. To sort the list, single click on any
column, JAMS will then sort the list in ascending order.

Each time you use the Search... option, the records which match your
selection criteria are added to the existing records. You can clear the list
by selecting Clear List from the Action menu.

7.5.2 File menu
The File pull-down menu is used to control the History window.

Connect...

This menu option activates a dialog box which allows you to connect to
a remote JAMS Server. Once connected, you can search History on that
server.

Disconnect

This menu option lets you disconnect from one of the remote JAMS
Servers which you are connected to.

Close

This menu option will close the History window.
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Exit

This menu option will close all of the JAMS windows and exit.

7.5.3 Action menu
The Action menu is used to perform an action on the History window or
the selected line in the History window. The options on the Action menu
include:

Show Detail

This option will display a window which shows detailed information about
the selected Job. From this detail window, you can also view the Jobs log
file.

You can also display a Jobs detail window by double clicking on the Job.

Search...

This option displays a dialog box in which you enter your selection criteria.
When you click on the Ok button, the search starts and a work in progress
box is displayed. The work in progress box has a Cancel button which can
be used to cancel a long search. If you cancel a search, all of the records
located thus far will be included in the list.

The number of records which a single search will add to the list can
be limited. Define the logical name JAMS_HISTORY_LIMIT to be the
desired limit. If this logical name is not defined, the limit defaults to 500
records.

Each time you use the Search... option, the records which match your
selection criteria are added to the existing records. You can clear the list
by selecting Clear List from the Action menu.

Clear List

This option clears all of the history lines from the list. Each time you
perform a search, the lines which match the search are added to the
current list.

7.5.4 Window menu
The Window menu is used to activate other portions of the JAMS
Windows interface. From the History window, you can activate the Submit
window, or the Monitor window.

7.5.5 History Search Window
The Search window is displayed to obtain search selection criteria. You
can enter:
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Search

Here you can select the Remote Node which is where the search will
actually occur on.

System ID

Enter a System ID to limit the history records to Jobs from the specified
System. Leave this field blank to display Jobs from any System.

Job Name

Enter Job Name with wildcards. The wildcard characters are * which
matches any set of characters and % which matches any single character.

Setup Name

Enter Setup Name with wildcards. The wildcard characters are * which
matches any set of characters and % which matches any single character.

Start/End Times

Enter the beginning and ending date and time range. Only Jobs submitted
within this range will be included in the list.

Final Status

You can limit your search to only Jobs with a specific final status severity.
Select the severities which you want to include in your list.

7.6 Using Help
There are three ways to obtain help from within the JAMS Windows
interface:

1 The Help pull-down menu.

2 The Help button on the Toolbar.

3 The Help (F1) key.

Help Menu

The Help menu has two options. If you select Help Topics option, a
JAMS Client help application appears.

The About JamsWin option displays the standard windows about box,
showing copyright and version information.

Toolbar Help

By selecting the Toolbar Help option you will find that the cursor changes
to a question mark and you can click on the component of the window on
which you would like help.
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Help Key - F1

If you press the Help F1 key, JAMS will provide help on the item in which
the cursor is located. If this item does not have any specific help, help will
be displayed on the next higher item (such as the window which contains
the item).

Help Button

Some dialog boxes have a Help button which will provide help which is
specific to the dialog box. In some cases, a dialog box will have a Help
button but it will not be active. This means that the dialog box is capable
of providing help but there is no help available for the specific message
being displayed by the dialog box.
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8 JAMS DECwindows/Motif Interface

This chapter describes the JAMS DECwindows/Motif Interface.

8.1 Starting the JAMS DECwindows/Motif Interface
When JAMS is installed, JAMS is added as a Session Manager/FileView
menu item. If you have not customized your Applications pull-down menu,
the JAMS menu item will be automatically added to your Applications
Menu.

If the JAMS menu item does not appear in your Applications Menu, pull-
down the Options Session Manager menu and select Menus.... This will
display a dialog box which lets you customize your menus. Add the JAMS
menu item to one of your menus and click on the Ok button.

Once the JAMS menu option is available on one of your menus, you can
select it to activate the JAMS DECwindows/Motif interface.

You can also activate the JAMS DECwindows/Motif interface by running
the JAMS_MASTER_MOTIF.EXE executable which is in JAMS_EXE:.

8.1.1 Remote Connections
You can define the logical name JAMS_REMOTE_CONNECTIONS to
be a list of remote node specifications JAMS will connect to when the
DECwindows/Motif interface starts. The remote node specifications should
be in the standard DECnet format as in the following example:

$ DEFINE JAMS_REMOTE_CONNECTIONS GRAPE, TRAFIC"MYPROXY"

In this example, when JAMS_MASTER_MOTIF starts up, connections will
be established to the remote node GRAPE using the current users default
DECnet proxy and to the remote node TRAFIC using the MYPROXY
username/proxy.

8.2 Submit Window
The Submit Window is used to select and submit JAMS Jobs which
are run on demand. The window consists of a default or user defined
menu hierarchy. The default hierarchy shows all of the JAMS Systems,
expanding a System displays all of the Jobs and Setups for the selected
System.

If you want to specify a user defined menu, define the logical name JAMS_
DEFAULT_MENU to be the name of the menu which you want to use as
the top level menu.
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Figure 8–1 DECwindows Submit Window

Figure 8–1 is an example of the Submit Window.

8.2.1 Navigating the Window
The Submit Window displays a menu hierarchy. A sub-menu is denoted
with a triangle to the left of the menu name. If the triangle points to the
right, the menu is not expanded. If the triangle points down, the menu is
expanded. To expand a menu, you can double click on the menu or, click
on the menu (to select it) and then pull down the Action menu and select
Expand. You can also press MB3 while the cursor is on the menu you
want to expand and then select Expand from the pop-up menu.

You can submit a Job or Setup by double clicking on the Job or Setup. You
can also select Submit from the pull-down or pop-up menu.

You can activate the JAMS History window and display a Jobs history by
selecting Show History from a pull-down or pop-up menu.

8.2.2 File menu
The File pull-down menu is used to control the Submit window.
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Connect to Server...

This menu option activates a dialog box which allows you to connect to
a remote JAMS Server. Once connected, you can submit Jobs on that
server.

Disconnect

This menu option lets you disconnect from one of the remote JAMS
Servers which you are connected to.

Settings...

This menu option activates a dialog box which allows you to select which
windows will be opened when the JAMS DECwindows/Motif interface is
started.

Save Settings

This menu option will save the current size and position of the JAMS
windows. These sizes and positions will be used the next time you start
the JAMS DECwindows interface.

Close Window

This menu option will close the Submit window. If there are no other
JAMS windows open, the image will exit.

Exit

This menu option will close all of the JAMS windows and exit.

8.2.3 Action menu
The Action menu is used to perform an action on the Submit window or
the selected line in the Submit window. The items in the Action menu
are also available from a pop-up menu. Press MB3 to display the pop-up
menu. The options on the Action menu include:

Expand

This option will expand the selected line. This option is only active when
the selected line is a menu line.

You can also expand or collapse a menu by double clicking on the menu
line.

Collapse

This option will collapse the selected menu line. This option is only active
when the selected line is a menu line.

You can also expand or collapse a menu by double clicking on the menu
line.

Collapse All

This option will collapse all expanded menus.
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Show History

This option activates the JAMS History Window, clears the current history
list and performs a search for history of the selected Job.

Submit

This option will submit the selected Job or Setup. A dialog box which
contains the jobs parameters will be displayed. If the Job has defined
reports, you can click on the Reports... button to display and possibly
override the report printing information.

8.2.4 Window menu
The Window menu is used to activate other portions of the JAMS
DECwindows/Motif interface. From the Submit window, you can activate
the History window, the Monitor window or the Definitions window.

8.3 Submitting a Job
When you submit a job, a dialog box which contains the jobs parameters
will be displayed. If the Job has defined reports, you can click on the
Reports... button to display and possibly override the report printing
information.

8.4 Monitor Window
The Monitor Window is used to monitor and manage the batch jobs which
are known by the JAMS. The JAMS Job Monitor is a high performance,
continuously updated display of all batch jobs scheduled or submitted by
end-users. This display also provides comprehensive job management
capabilities.

8.4.1 The Monitor Display
The Monitor Window includes two types of display lines, top level
categories and Jobs. A top level category line includes an icon which
shows whether or not the line is expanded, the number of jobs in the
category, the name of the category and detail headings. You can expand or
collapse a category line by double clicking on the line.

Figure 8–2 is an example of the Monitor Window.

8.4.2 Monitor Detail Lines
When a Job is executing, the Monitor includes the following information:

Entry

This is the JAMS entry number for the job.
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Figure 8–2 DECwindows Monitor Window

Job Name

This is the name of the job as specified in the JAMS Job definition.

Node

This is the name of the node on which this job is running.

CPU %

This column shows the CPU utilization percentage for this job during the
most recent update interval.

DIO/s

This column shows the average number of direct I/O’s per second which
this job performed during the most recent update interval.

Completion %

If this job is registered in the JAMS database, we can compute the
completion percent based on the Job’s past performance. This percentage
is an estimate of how close to completion the Job is. This can be a useful
monitoring tool. If an operator sees a Job which shows a completion
percentage of 200%, they know that the Job has used twice the resources
which it normally takes and they may want to take corrective action.

This percentage is calculated using the Jobs current and average CPU
usage and Direct I/O count so running the a Job on a heavily loaded
system will not affect this calculation.

8–5



JAMS DECwindows/Motif Interface

Completion Time

If this Job is registered in the JAMS database, we can calculate how much
longer the Job is going to run based on the Job’s past performance. This
calculation is based on the Job’s current CPU utilization and direct I/O per
second count. We extrapolate this data to determine how much longer the
job will run before reaching its average CPU usage and direct I/O count.

Elapsed Time

This shows how long the Job has been executing, in hours and minutes.

CPU Time

This shows how much CPU time the Job has accumulated, in hours and
minutes.

DIO Count

This shows the number of direct I/O operations performed by the Job.

8.4.3 File menu
The File pull-down menu is used to control the Monitor window.

Connect to Server...

This menu option activates a dialog box which allows you to connect to
a remote JAMS Server. Once connected, you can monitor Jobs on that
server.

Disconnect

This menu option lets you disconnect from one of the remote JAMS
Servers which you are connected to.

Settings...

This menu option activates a dialog box which allows you to select which
windows will be opened when the JAMS DECwindows/Motif interface is
started.

Save Settings

This menu option will save the current size and position of the JAMS
windows. These sizes and positions will be used the next time you start
the JAMS DECwindows interface.

Close Window

This menu option will close the Monitor window. If there are no other
JAMS windows open, the image will exit.

Exit

This menu option will close all of the JAMS windows and exit.
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8.4.4 Action menu
The Action menu is used to perform an action on the Monitor window or
the selected line in the Monitor window. The items in the Action menu
are also available from a pop-up menu. Press MB3 to display the pop-up
menu. The options on the Action menu include:

Expand

This option will expand the selected line. All current and future jobs
in this category will be displayed. This option is only active when the
selected line is a top level line.

You can also expand or collapse a category by double clicking on the
category line.

Collapse

This option will collapse the selected line. The jobs in this category will no
longer be displayed. This option is only active when the selected line is a
top level line.

You can also expand or collapse a category by double clicking on the
category line.

Collapse All

This option will collapse all of the top level categories.

You can also expand or collapse a category by double clicking on the
category line.

Show Detail

This option will display a window which shows detailed information about
the selected Job. This information will be updated as the Job executes.

You can also display a Jobs detail window by double clicking on the Job.

Show History

This option activates the JAMS History Window, clears the current history
list and performs a search for history of the selected Job.

Release

Jobs can be in a pending or holding state for many different reasons.
When you elect to release a job, a window will appear showing all the
reasons this particular job is not running. You can then decide to remove
some, or all of the constraints which are keeping the job from executing.

Hold

The selected job is held until released.

Reschedule

This option is used to change the scheduling attributes of a job which is
not executing. A dialog box is displayed which allows you to change the
attributes of the job.
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Restart

This option is used to abort and restart an executing job. A window is
displayed which allows you to specify where the job should execute as well
as the hold status. If you complete the form and click on the Ok button,
the job is aborted and either restarted or placed on hold.

Abort/Delete

If the selected job is currently executing it is aborted. Otherwise the job is
deleted from the schedule.

8.4.5 Window menu
The Window menu is used to activate other portions of the JAMS
DECwindows interface. From the Monitor window, you can activate
the Submit window, the History window or the Definitions window.

8.5 History Window
The History Window is used to search and examine batch job execution
history.

Figure 8–3 is an example of the History Window.

Figure 8–3 DECwindows History Window
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8.5.1 The History Display
The History display window contains one line for each history record
which matched your selection criteria. Each line shows the Job Name,
final status and, submit, start and completion time. You can double click
on a line to display a detail window.

You can sort the list by Job Name, Start Time or End Time. To sort the
list, pull down the Action menu, move to Sort and then select one of the
sort options from the cascade menu.

Each time you use the Search... option, the records which match your
selection criteria are added to the existing records. You can clear the list
by selecting Clear List from the Action menu.

8.5.2 File menu
The File pull-down menu is used to control the History window.

Connect to Server...

This menu option activates a dialog box which allows you to connect to
a remote JAMS Server. Once connected, you can search History on that
server.

Disconnect

This menu option lets you disconnect from one of the remote JAMS
Servers which you are connected to.

Settings...

This menu option activates a dialog box which allows you to select which
windows will be opened when the JAMS DECwindows/Motif interface is
started.

Save Settings

This menu option will save the current size and position of the JAMS
windows. These sizes and positions will be used the next time you start
the JAMS DECwindows interface.

Close Window

This menu option will close the History window. If there are no other
JAMS windows open, the image will exit.

Exit

This menu option will close all of the JAMS windows and exit.

8.5.3 Action menu
The Action menu is used to perform an action on the History window or
the selected line in the History window. The options on the Action menu
include:
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Show Detail

This option will display a window which shows detailed information about
the selected Job. From this detail window, you can also view the Jobs log
file.

You can also display a Jobs detail window by double clicking on the Job.

Search...

This option displays a dialog box in which you enter your selection criteria.
When you click on the Ok button, the search starts and a work in progress
box is displayed. The work in progress box has a Cancel button which can
be used to cancel a long search. If you cancel a search, all of the records
located thus far will be included in the list.

The number of records which a single search will add to the list can
be limited. Define the logical name JAMS_HISTORY_LIMIT to be the
desired limit. If this logical name is not defined, the limit defaults to 500
records.

Each time you use the Search... option, the records which match your
selection criteria are added to the existing records. You can clear the list
by selecting Clear List from the Action menu.

Sort

The option allows you to sort the current list by Job Name, Start time or
End time.

Clear List

This option clears all of the history lines from the list. Each time you
perform a search, the lines which match the search are added to the
current list.

8.5.4 Window menu
The Window menu is used to activate other portions of the JAMS
DECwindows interface. From the History window, you can activate the
Submit window, the Monitor window or the Definitions window.

8.5.5 History Search Window
The Search window is displayed to obtain search selection criteria. You
can enter:

System ID

Enter a System ID to limit the history records to Jobs from the specified
System. Leave this field blank to display Jobs from any System.

Job Name

Enter Job Name with wildcards. The wildcard characters are * which
matches any set of characters and % which matches any single character.
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Start/End Times

Enter the beginning and ending date and time range. Only Jobs submitted
within this range will be included in the list. If you leave the times blank,
they default to midnight for the start time and 23:59:59.99 for the end
time.

Final Status

You can limit your search to only Jobs with a specific final status severity.
Select the severities which you want to include in your list.

8.6 Definitions Window
The Definitions Window is used to maintain the JAMS database.

Figure 8–4 is an example of the Definitions Window.

Figure 8–4 DECwindows Definitions Window
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8.6.1 Button Bar
The Definitions window includes a button bar which includes:

• An option button used to select the current view.

• A Search button used to initiate a search which will augment or
replace the entries in the current view.

• A Show Detail button which is used to display the detail of the selected
entry.

• A Modify button which is used to modify the detail of the selected
entry.

• An Add button which is used to add a new definition.

8.6.2 The Definitions Display
The Definitions display window contains one line for each record which
matched your selection criteria. You can double click on a line to display a
detail window.

8.6.3 File menu
The File pull-down menu is used to control the Definitions window.

Connect to Server...

This menu option is disabled in the Definitions window.

Disconnect

This menu option is disabled in the Definitions window.

Settings...

This menu option activates a dialog box which allows you to select which
windows will be opened when the JAMS DECwindows/Motif interface is
started.

Save Settings

This menu option will save the current size and position of the JAMS
windows. These sizes and positions will be used the next time you start
the JAMS DECwindows interface.

Close Window

This menu option will close the Definitions window. If there are no other
JAMS windows open, the image will exit.

Exit

This menu option will close all of the JAMS windows and exit.
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8.6.4 Action menu
The Action menu is used to perform an action on the Definitions window
or the selected line in the Definitions window. The options on the Action
menu include:

Search...

Pops up the search dialog box for the current view. When you click on the
Ok button, the search starts and a work in progress box is displayed. The
work in progress box has a Cancel button which can be used to cancel a
long search. If you cancel a search, all of the records located thus far will
be included in the list.

Clear List

Clears the list for the current view.

Show Detail

Displays the detail of the currently selected line.

Show History

Pops up the JAMS History window and performs a search based upon the
currently selected line in the Definitions window.

Modify

Displays the detail of the currently selected line and allows modification.

Submit

Submits the currently selected line in the Definitions window.

Copy

Copies the currently selected item to a new name.

Add

Adds a new item. This is a cascading menu which allows you to add a
System, Trigger, Variable or Menu.

Delete

Deletes the currently selected item. A confirmation dialog box is displayed
to confirm the delete.

8.6.5 Window menu
The Window menu is used to activate other portions of the JAMS
DECwindows interface. From the Definitions window, you can activate
the Submit window, the Monitor window or the History Window.
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8.6.6 Management menu
The Management menu is used to view or modify various JAMS
management objects. The options on this menu include:

Dates

Used to specify special dates used for scheduling or date parameters.

Access Control

Used to define Access Control Lists which control access to various JAMS
options.

Remote Nodes

Used to define remote nodes which are also running JAMS. These nodes
may be used for remote job dependencies.

Node Groups

Used to define groups of remote nodes which may be used to define job
dependencies. Defining a dependency on a job at a remote node group is
the same as defining a dependency for the job on each node in the node
group.

Configuration

Used to define JAMS configuration options.

Date Types

Used to define special date types.

8.6.7 Search Criteria
When you initially select a category of definitions, or when you press the
Search button, you are presented with a search criteria dialog box.

Only records which match the criteria entered will be displayed in the
Definitions window. You can also choose to clear the list before performing
the new search.

8.7 Connect Dialog
When you select Connect to Server from the File menu, a dialog box is
displayed which has three fields, Server Name, Username and Password.
The Server Name is the DECnet node name of the server you want to
connect to. You can leave the Username and Password fields blank to
access the server via a DECnet proxy. You can also enter a Username and
leave the Password blank to use a specific DECnet proxy.
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8.8 Using Help
There are three ways to obtain help from within the JAMS DECwindows
interface:

1 The Help pull-down menu.

2 Press the Help key.

3 Some windows have a Help button.

Help Menu

The Help menu has a number of options. If you select On Context, the
cursor changes to a question mark and you can click on the component of
the window on which you would like help.

The On Window option will provide help on the entire window.

The Tutorial option provides a tutorial on JAMS. This is a good place to
start if you are new to JAMS.

The Using Help option displays the text you are now reading.

The On Version option displays a dialog box which contains version and
support information.

Help Key

If you press the Help key, JAMS will provide help on the item in which the
cursor is located. If this item does not have any specific help, help will be
displayed on the next higher item (such as the window which contains the
item).

Help Button

Some dialog boxes have a Help button which will provide help which is
specific to the dialog box. In some cases, a dialog box will have a Help
button but it will not be active. This means that the dialog box is capable
of providing help but there is no help available for the specific message
being displayed by the dialog box.
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9 Submitting Ad Hoc Jobs

This chapter explains how JAMS can make it easier to submit batch jobs.
Traditional job scheduling systems help manage regularly scheduled batch
jobs. One of the strengths of JAMS is that it also helps you manage ad
hoc jobs, job which are run only when needed. JAMS provides a simple,
menu driven means to select a job and then uses ‘‘fill-in-the-blanks’’ video
forms to prompt the user for the job’s parameters and printing options.

While the end-user is responsible for requesting the job and providing
values for the parameters, JAMS still schedules the job based upon
the Job and System definitions which can be maintained by the MIS
Department.

9.1 Submitting a JAMS Job
The JAMS_MASTER program is used to submit batch jobs.
JAMS_MASTER provides menu based access to job submission as well
as a SUBMIT command which is very similar to the standard OpenVMS
SUBMIT command.

Using JAMS does not preclude or diminish the value of using the
OpenVMS SUBMIT command. In fact, JAMS can track and maintain
history for jobs submitted via the standard SUBMIT command.

9.1.1 Replacing the OpenVMS SUBMIT Command
You can define a symbol which will simulate the standard OpenVMS
SUBMIT command. JAMS accepts the SUBMIT command and many
of the same qualifiers as the standard OpenVMS SUBMIT command.
The following example shows how you can define a symbol to replace the
OpenVMS SUBMIT command.

$ SU*BMIT :== $JAMS_EXE:JAMS_MASTER.EXE SUBMIT Return

$ SUBMIT MYJOB

This example defines the DCL symbol SUBMIT (which can be abbreviated
to the first two or more characters), then uses this symbol to submit the
Job MYJOB. The standard OpenVMS SUBMIT command would look for a
file named MYJOB.COM in the current default directory and submit the
command file to the SYS$BATCH queue.

JAMS would look for a Setup or Job named MYJOB in its database. If
found, it would determine the name and location of the command file,
prompt for any parameters, and submit the Job to the schedule. The
Job may run in a queue or as a detached process, depending upon the
Execution Method defined for the Job. The Job may be defined to run on
OpenVMS, Windows NT, or a UNIX/Linux system.
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Note: Even though the Job is being initiated on OpenVMS, the Job itself
may very well run on Windows NT or UNIX/Linux. The Execution
Method along with the Agent Node determines how the Job is
submitted, the Operating System it will run on, and the node
where the Job runs.

Command line access to JAMS batch jobs is generally used by more
technically oriented people. JAMS batch jobs can be very useful for
software development activities, such as program compiles, because JAMS
can save the value of a job’s parameters in DCL symbols so that the next
time the job is submitted, the parameter defaults are recalled.

9.2 Selecting a Job to Submit
If your site is a typical OpenVMS environment, you eventually accumulate
hundreds or even thousands of batch jobs. JAMS can help you manage all
these jobs and provide a menu based environment which will help you find
the exact job which you want to submit.

If you know the name of the Job which you want to submit, you can use
the JAMS SUBMIT command to submit the Job. In many cases, the exact
name of a job is not remembered. This is when JAMS menu based access
to batch jobs becomes indispensable.

The Job Submission menu option on the JAMS_MASTER main menu is
the entry point to JAMS menu based job selection. A typical, user defined
menu is shown in Figure 9–1.

This menu has three columns, they are:

1 The name of the line item.

2 The type of the line item, M for Menus, J for Jobs and S for Setups.

3 The Description of the line item (which may span two lines).

The list of line items may be longer than can be shown on the screen. You
can use the arrow keys or the Next Screen and Prev Screen keys to scroll
through the list of options.

Position the cursor on the desired line item and press Return . If you
selected another menu, the current line items will be replaced by the line
items from the selected menu. If you selected a Job or Setup, a sequence
of screens will be presented which allow you to provide values for the Job’s
parameters and Report overrides.

9.2.1 Parameters
When you use JAMS to submit a job which has parameters, a parameter
form will be dynamically created and displayed. Each field on the form
consists of the parameter’s prompt text and a variable field where you can
enter the value of the parameter. If a Job has many parameters, there
may be more than one parameter form.
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Figure 9–1 Job Submission Menu

Figure 9–2 shows an example of a parameter entry form.

All of the fields on a parameter screen are user defined. Each field has one
of four possible formats:

1 Text - Any character may be entered. Input may be forced to
uppercase. The length of the entry is limited.

2 Integer - Only the numeric digits may be entered. The length of the
entry may be limited.

3 Date - The field has a default format of MM/DD/YY where MM
represents a two digit month, DD represents a two digit day of the
month and YY represents the two digit year of the century. This
format can be customized on a per user basis. See Section 5.2.5 for
more information.

4 Time - The field has a default format of HH:MM II where HH
represents a hour (in 12 hour format), MM represents the minutes
and II represents the meridian indicator (AM or PM). This format
can be customized on a per user basis. See Section 5.2.5 for more
information.
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Figure 9–2 Sample Parameter Form

You can enter values for the parameters or accept the defaults. When
JAMS determines the default value for a parameter, it takes the following
steps:

1 Use the default value entered in the parameter definition.

2 If a Setup is being submitted, use the default value from the Setup’s
parameter screen.

3 If /USE_SYMBOLS is specified (which is the default), see if there is
a DCL symbol with the same name as the parameter and use the
symbol’s value, if defined.

4 If a value was specified with the /PARAMETER qualifier, use the
specified value.

9.2.2 Report Overrides
After you have responded to any parameter forms, the Job/Report override
form will be displayed. This form will vary depending on how many
Reports are defined for the Job. If the the Job does not have any Reports
defined, the form will contain only the Job overrides. If the Job has only
one Report, the Job and Report override fields will be displayed on the
same form.
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Figure 9–3 Sample Job/Report Override Form, one Report

Figure 9–3 shows an example of the Job/Report override form for a Job
which has only one Report.

The fields on this form are:

Schedule Job for

This is the date and time when the Job will be released to run. The Job is
submitted immediately but, if a date and time is specified here, the job will
remain in a pending state until the indicated date and time. This field is
equivalent to the OpenVMS /AFTER= qualifier of the SUBMIT command.

Print Queue

This is the OpenVMS print queue where the indicated Report will be
printed. The default is defined in the Report Definition. You can override
this queue but any value you enter must be a valid OpenVMS print
queue.

Print Form

This is the OpenVMS print form which should be used when the indicated
Report is printed. The default is defined in the Report Definition. If left
blank, the default form of the specified Print queue will be used.
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Number of Copies

This is the number of copies of the indicated Report which should be
printed. The default is defined in the Report Definition. To suppress
printing of the Report, enter zero.

If the Job has more than one Report, the Reports are contained in a list
along with the Job override fields. After filling in the Scheduled date and
time, you can position the cursor to a specific Report and press the Select

key to modify the Report’s information. When you press the Select key, a
pop-up form will appear which contains the same fields as a single Report
screen.

Figure 9–4 shows an example of the Job/Report override form for a Job
which has more than one Report.

Figure 9–4 Sample Job/Report Override Form, many Reports
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10 Entering Generic Date Specifications

This chapter explains generic, English language based date specifications.

10.1 Date Specifications
There are many places in the JAMS system where you need to specify a
date. Sometimes an exact date specification is adequate, but usually not.
Most of the time, you want to specify a generic date.

In cases where a generic date is desirable, JAMS accepts an English
language based date specification. JAMS capability for understanding
date specifications is quite extensive.

There are three key times when JAMS will accept a generic date
specification, in a scheduled date, as default parameter values and as
Setup parameter values.

10.1.1 Scheduled Date
When you specify the scheduled date for a Job or Setup, you use generic
date specifications.

10.1.2 Default Parameter Values
When you define a parameter for a Job, if the parameter’s data type is
DATE, you can specify a default value for the parameter using generic
date specifications.

When a user selects the Job, they are presented with a screen based form
used to obtain the values for the Jobs parameters. Parameters with a
data type of DATE are presented as a standard MM/DD/YY date field but
JAMS uses the generic date specification to determine what the default
date should be.

10.1.3 Setup Parameter Values
When you define a Setup, you are prompted for the values for the Job’s
parameters. If the Job has any parameters which have a data type of
DATE, the parameter form will have a sixty character text field for the
date parameter, rather than the standard MM/DD/YY type of field. You
can then enter a generic date specification.

This is extremely important for Setups which are automatically submitted.
When JAMS automatically submits Jobs, prompting for the value of
parameters is not possible. The generic date specification is evaluated to
obtain the value for the parameter.
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10.2 Simple Specifications
Simple date specifications specify a date relative to the current date. The
format for a simple date specification is:�������������
������������

� NEXT
THIS
LAST

�
day-of-week

WORKDAYS
WEEKDAYS
TODAY
TOMORROW
YESTERDAY
DAILY

�������������
������������

[+/- number-of-days]

10.2.1 Description of components

day-of-week

The day-of-week can be the full name of a weekday or the first three
characters of a weekday name.

When you specify a day of the week, such as MONDAY, JAMS interprets
this as ‘‘Monday of this week’’. In this context, a week begins on Monday
and ends on Sunday.

The days of the week can be preceeded by a modifier such as LAST, THIS
or NEXT. The THIS modifier has no effect and is supported for readability.

When you use a modifier, such as LAST, JAMS interprets this to mean
‘‘weekday of last week’’. Thus, the text ‘‘LAST THURSDAY’’ will return
the same date no matter what day of the week it is interpreted.

WORKDAYS

This specifies the first workday which is on or after the current date.
Workdays are defined in the JAMS configuration and in Date Definitions.

WEEKDAYS

This specifies the first weekday which is on or after the current date.

TODAY

Specifies the current date.

TOMORROW

Specifies the current date plus one day.

YESTERDAY

Specifies the current date minus one day.
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DAILY

This is synonymous with TODAY and is provided for readability. Specifies
the current date.

+/- number-of-days

A simple date specification can optionally have a positive or negative
integer appended to it which adds or subtracts the indicated number of
days.

10.2.2 Valid Simple Date Specifications
Some examples of valid, simple date specifications are:

• TODAY + 5

• NEXT MON

• LAST TUESDAY

• WORKDAYS

10.3 Complex Specifications
Complex date specifications are used to specify a date relative to an
arbitrary period of time. By period of time, we mean something like a
month, or fiscal period.

A complex date specification may be thought of as two components, the
day specification and the period specification. For example, in the text ‘‘1st
WORKDAY of NEXT MONTH’’, the day specification is ‘‘1st WORKDAY’’
and the period specification is ‘‘NEXT MONTH’’.

The general format of a Complex Date specification is as follows:

[day-of-period OF] period [+/- number-of-days]

The syntax for the day-of-period specification can take one of two forms.
Both forms are equivalent, the choice of which form to use is left to the
user. The two forms of the day-of-period specification are:	





�

FIRST
LAST
1[st]
2[nd]
3[rd]
integer [th]

�
�

�����
����

day-of-week
WORKDAY
WEEKDAY
DAY
MONTH

�����
����

or

�����
����

day-of-week
WORKDAY
WEEKDAY
DAY
MONTH

�����
����

	






�

OF

�������
������

FIRST
LAST
1[st]
2[nd]
3[rd]
integer [th]

�������
������

WEEK

�
�

If you do not specify the day of period, the default is the current day.
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The syntax for the period specification is:��������
�������

�
THIS
NEXT
LAST

�
�������
������

YEAR
MONTH
month-name
Date-Type
Specific-Date-Type
Date-Type Specific-Date-Type

�������
������

��������
�������

While this syntax specification seems ominous, it is actually a
representation of how people commonly specify dates.

10.3.1 User Defined Periods
If you specify a period by using user defined Date Types, you may have to
specify both the Specific and generic Date Types. For example, if you have
defined the Date Type FISCAL with Specific Date Types of PERIOD_01
through PERIOD_12, you can specify the second period as:

‘‘FISCAL PERIOD_02’’ or ‘‘PERIOD_02’’.

If you defined two Date Types which both use the Specific Type of
PERIOD_02, then you must specify ‘‘FISCAL PERIOD_02’’.

10.3.2 Weeks
When used in the context of a period, a week is defined as starting on the
first day of the period and continuing for seven days.

10.3.3 Valid Complex Date Specifications
The following examples of valid complex date specifications are based on
the current date being March 1st, 1991.

Specification Date

FIRST MONDAY OF NEXT MONTH 01-APR-1991

2ND MONDAY OF THIS MONTH 12-MAR-1991

FIRST MONDAY OF LAST MARCH 05-MAR-1990

6TH WEEKDAY OF NEXT MONTH 08-APR-1991

6TH WEEKDAY OF MONTH 08-MAR-1991
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This chapter explains management of JAMS.

11.1 JAMS Processes
When the JAMS start-up procedure is executed on OpenVMS one, two
or three detached processes will be started. The JAMS_MONITOR
process is started on all OpenVMS nodes and the JAMS_SCHEDULE
and JAMS_NETWORK processes are started on one OpenVMS node in the
VMScluster.

On Windows NT/2000 systems, the JAMS Agent service must be running.

11.1.1 The JAMS_MONITOR process
The JAMS_MONITOR process must be running on all OpenVMS nodes
which will process batch jobs. The JAMS_MONITOR process monitors
the creation and termination of batch processes. It also will redirect
connection requests from remote nodes to the node in the VMScluster
which is running the JAMS_NETWORK process. Do not confuse the
JAMS_MONITOR process with the JAMS Job Monitor function. The
JAMS_MONITOR is notified of the creation of a batch process by the
JAMS_REGISTRAR program.

The JAMS_REGISTRAR program should be executed by the OpenVMS
system wide login command file (it will have no effect on non batch
processes). The JAMS_REGISTRAR program sends a message to the
JAMS_MONITOR to alert the monitor that a batch job has started. It also
sets the batch job’s termination mailbox to point to the JAMS_MONITOR’s
mailbox. The OpenVMS job controller will place a message in the job’s
termination mailbox when the job terminates, no matter how the Job
terminates. The JAMS_MONITOR process will verify the mailbox
messages which it receives and forward them to the JAMS_SCHEDULE
process.

Note: If you are using other software which uses the termination
mailbox, make sure that the termination mailbox is set up for the
other software before running the JAMS_REGISTRAR program.
The JAMS_MONITOR process will receive the termination message
and forward it to the second mailbox.

The JAMS_MONITOR process will also keep track of the
JAMS_SCHEDULE and JAMS_NETWORK processes to make sure that
there is one of each running in the VMScluster.
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11.1.2 The JAMS_SCHEDULE process
There should always be one JAMS_SCHEDULE process running in a
VMScluster. The JAMS_MONITOR processes in the cluster (one on each
node) will keep track of the JAMS_SCHEDULE process and if the process
dies or the node which the JAMS_SCHEDULE process is executing on
leaves the cluster, one of the remaining JAMS_MONITOR processes will
fire up another JAMS_SCHEDULE process on a remaining node.

The JAMS_SCHEDULE process receives messages from the
JAMS_MONITOR processes and performs the following basic tasks:

• Updates Job History.

• Examines Jobs submitted by the JAMS Submit sub-system to
determine if all of the Jobs dependencies have been satisfied.

• Fires Triggers when their events occur.

• Releases Jobs when their dependencies are satisfied.

• Verifies that resources are available for a Job.

• Releases Jobs when their resources become available.

• Sends notification of failed Jobs via OpenVMS Mail, operator requests
and broadcasts.

• Sends messages to JAMS Job Monitors when the status of a job
changes.

11.1.2.1 Controlling the JAMS_SCHEDULE node selection
The JAMS_SCHEDULE process must be running on one node
in a VMScluster. If a JAMS_MONITOR process detects that the
JAMS_SCHEDULE process is not running, it will start one.

In a large VMScluster, you may have many different types of systems,
these may range from fast Alpha class systems to small VAXstation 2000’s.
Generally, you want the JAMS_SCHEDULE process to run on one of your
more powerful nodes, or one with available capacity.

You can control which node the JAMS_SCHEDULE process will start on
by defining the logical name JAMS_SCHED_WEIGHT. This logical must
be defined in the system logical name table, have the executive attribute
and translate into a numeric value. If JAMS_SCHED_WEIGHT is not
defined, or is defined incorrectly, then the value 1 will be used.

Nodes which have JAMS_SCHED_WEIGHT defined as 0 (zero) will never
start a JAMS_SCHEDULE process. In fact, they won’t even check to see if
a schedule process is running.

When a monitor detects that the schedule process is not running, it will
compare the value of it’s JAMS_SCHED_WEIGHT logical with the values
of the other nodes in the VMScluster. The node with the highest value will
then start a schedule process.
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If you want to move the JAMS_SCHEDULE process off of the node
which it is currently running on, you can use the STOP SCHEDULE and
START SCHEDULE commands. You may need to do this if your primary
node goes down and the Schedule process starts on one of the secondary
nodes. Note however that when the Schedule process is restarted, it will
start on the node with the highest JAMS_SCHED_WEIGHT value.

11.1.2.2 Customizing JAMS_SCHEDULE startup
You can customize the start up of the JAMS_SCHEDULE process by
creating the JAMS_COM:JAMS_SCHEDULE_STARTUP.COM command
procedure. If this command procedure exists, it is executed by the
JAMS_SCHEDULE process when it starts. You can use this command
procedure to define process level logical names, set RMS buffers or perform
almost any other type of initialization.

11.1.3 The JAMS_NETWORK process
The JAMS_NETWORK process provides wide area network
communications support. When JAMS needs to communicate with a
remote node, a message is sent to the local JAMS_NETWORK process
which will establish a link with the remote node and send the message. If
a link cannot be established, the JAMS_NETWORK process will save the
message and periodically retry.

11.1.3.1 Controlling the JAMS_NETWORK node selection
The JAMS_NETWORK process is similar to the JAMS_SCHEDULE
process in that there is only one JAMS_NETWORK process per
VMScluster. If you will be using the wide area network features of
JAMS, the JAMS_NETWORK process must be running on one node
in the local VMScluster and one node on the remote VMScluster. If a
JAMS_MONITOR process detects that the JAMS_NETWORK process is
not running, it will start one.

Generally, you want the JAMS_NETWORK process to run on one of your
more powerful nodes, or one with good network connections.

You can control which node the JAMS_NETWORK process will start on by
defining the logical name JAMS_NETWORK_WEIGHT. This logical must
be defined in the system logical name table, have the executive attribute
and translate into a numeric value.

Nodes which have JAMS_NETWORK_WEIGHT defined as 0 (zero) will
never start a JAMS_NETWORK process. In fact, they won’t even check
to see if a network process is running. Also, if this logical name is zero,
a remote node will not be able to establish a connection because the
JAMS_MONITOR process will not redirect remote network connection
requests to the node which is running the JAMS_NETWORK process.

When a monitor detects that the network process is not running, it will
compare the value of it’s JAMS_NETWORK_WEIGHT logical with the
values of the other nodes in the VMScluster. The node with the highest
value will then start a network process.
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If the JAMS_NETWORK_WEIGHT is not defined, or is defined incorrectly,
then the value 1 will be used.

If you want to move the JAMS_NETWORK process off of the node
which it is currently running on, you can use the STOP NETWORK and
START NETWORK commands. You may need to do this if your primary
node goes down and the network process starts on one of the secondary
nodes. Note however that when the network process is restarted, it will
start on the node with the highest JAMS_NETWORK_WEIGHT value.

11.1.4 The JAMS Agent Windows NT/2000 Service
The JAMS Agent Windows NT/2000 Service receives requests and sends
responses to the JAMS_SCHEDULE which is running in the VMScluster.
The JAMS Agent’s purpose is to initiate the batch job which is received
from the JAMS_SCHEDULE and to provide status back to the JAMS_
SCHEDULE when the job completes.

Communication between the JAMS_SCHEDULE process and the JAMS
Agent is secured. Only JAMS_SCHEDULE processes can access the JAMS
Agent service running on Windows NT/2000.

The communication between JAMS_SCHEDULE and the JAMS Agent
can be further secured through the use of a password. The password
is only necessary in those situations where you have multiple systems
(VMSclusters and stand-alone systems) running the JAMS_SCHEDULE
process, and you wish to specify the JAMS_SCHEDULE processes
which should be able to schedule batch jobs on any specific Windows
NT/2000 system. The password must be set in the JAMS Database on the
OpenVMS system as well as in the control applet on the Windows NT/2000
system.

If you have only one OpenVMS system (VMScluster or stand-alone) or all
of your OpenVMS systems are trusted to submit batch jobs to the Windows
NT/2000 system, then the password is not needed.

For JAMS to successfully submit jobs to Windows NT/2000 systems the
following conditions must be established:

• The JAMS Agent Service must be installed on the Windows NT/2000
Server or Workstation system. The installation must occur using a
Windows NT/2000 Administrator account (local or Domain).

• Verify that the JAMS Agent NT Service is running.

• The Agent Node Name, found under the Submit Options of the Job,
must specify the Windows NT/2000 computer name where the job will
run.

• The Execution Method, found under the Source Options of the Job
must specify a Windows NT/2000 Execution Method. JAMS ships with
three NT Execution Methods already established. They are:

• NT. Non-parsed batch file.

• NTCMD. Non-parsed one line NT command.

• NTPARSE. Parsed batch file.
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• A username/password combination must be previously established
which is passed to the JAMS Agent by the JAMS_SCHEDULE process.
See the JAMS Reference Manual for detailed instructions on how to
establish this information in the JAMS database. The JAMS Agent
first authenticates this username/password combination against the
local Windows NT/2000 security system. If this fails, authentication
will be attempted against the Windows NT/2000 Domain that this
computer is in.

• The username above, must have the ‘‘Logon as Batch Job’’ Windows
NT/2000 privilege.

11.1.5 Log Files
The JAMS Monitor, Schedule and Network processes share a common log
file which they use to log events when they occur. This log file is named
JAMS.LOG and is located in JAMS_DATA:. You can type this file at any
time.

11.2 Recurring Jobs
JAMS has the capability to automatically submit recurring Jobs. This is
done by the JAMS_AUTOSUBMIT batch Job. This Job is scheduled to
run every day at 1:00 am, including non-workdays.

You must submit this Job after the initial installation of JAMS. After the
initial submission, you should make sure that the JAMS_AUTOSUBMIT
Job is scheduled. If your recurring Jobs are not submitted, it may be
caused by a failure of the JAMS_AUTOSUBMIT Job.

The Jobs supplied with JAMS are in the System named JAMS. You should
update this System Definition to add the appropriate names to the list
of people who should be notified when a Job is this System fails. This is
especially important since the failure of the JAMS_AUTOSUBMIT Job
will prevent other Jobs from running.

11.3 Relative CPU Power Ratings
The JAMS job history information includes the amount of CPU processing
time consumed by a job. If you have a VMScluster which consists of nodes
with varying CPU speeds, you may want to define relative CPU ratings for
each CPU in your cluster.

The CPU rating is used when JAMS reports CPU utilization history and
when making projections. The CPU rating is expressed as a percentage. If
the CPU rating is undefined, it is assumed to be 100 percent.

If, for example, you have a VMScluster which consists of 5 VAX 64X0’s
(7.0 VUP’s per CPU) and one VAX 65X0 (13 VUP’s per CPU), you could
leave the CPU rating undefined on the 64X0’s (which would default to 100
percent) and define the CPU rating for the 65X0 as 185 percent (13/7).
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You define a nodes CPU rating by defining the logical name
JAMS_CPU_RATING. This logical name must be defined in the system
logical name table and it must be defined with the executive qualifier. The
following command would define a CPU rating of 185 percent:

$ DEFINE/SYSTEM/EXECUTIVE JAMS_CPU_RATING 185

This CPU rating is an arbitrary rating of the CPU processing speed
relative to the other nodes in your VMScluster.

For SMP machines which may have multiple CPU’s, the CPU rating
should be based on the relative power of a single CPU.

11.4 Security
JAMS includes a feature which allows an unprivileged (but authorized)
user to submit a batch job which will run under a different, possibly
privileged, username. This feature must be carefully managed in order to
prevent abuse.

This concept may be alarming at first but, if properly managed this
feature can enhance your overall security. With JAMS, instead of granting
a person the privileges they need to perform a simple task, privileges
which could be misused, you grant them submit access to a specific Job
or System which contains Jobs to perform the privileged tasks. Since the
user cannot modify the Job definitions, they cannot misuse the privileges.
You can essentially grant a person privileges for a limited set of functions.

In order to insure the security of your OpenVMS and JAMS environment,
you must follow these guidelines:

• Use the SET USERNAME command to define Access Control Lists
which grant submit access to OpenVMS usernames. This can
eliminate the need to give people the CMKRNL privilege.

• If a JAMS System runs under a privileged username, make sure that
the directory where the Systems command files are located is secure.
Also make sure that access to the System definition is secure.

• If a JAMS System runs under a privileged username, make sure that
the JAMS template library used by the system is secure.

When JAMS is first installed, you must have the OpenVMS BYPASS
privilege to perform any activity in the JAMS database. You can ease this
restriction using the Access Control menu option in JAMS_MASTER. As
long as you protect any System or Job definitions which execute under a
privileged username, JAMS will not pose a security risk and in fact, will
enhance your overall security.
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11.5 Backing Up the JAMS Database
Currently, the JAMS database consists of a number of RMS files. These
files are created by the installation procedure. The JAMS database files
are located in the directory which is pointed to by the JAMS_DATA
logical name. This logical name is defined by the JAMS_STARTUP.COM
command procedure. These files are protected from normal user access by
standard OpenVMS file protections.

Normally, the JAMS_SCHEDULE process has many of these files open for
write access. Because of this, you cannot make a valid backup copy of the
JAMS database without stopping the JAMS_SCHEDULE process.

The JAMS_MASTER program has a STOP SCHEDULE command. This
command is intended to be used during the backup of the JAMS database.
JAMS will not lose any information while the Schedule process is down
but, jobs which are submitted by the JAMS Submit sub-system will
remain in a pending state until the Schedule process is restarted. The
general procedure is:

1 Issue the JAMS STOP SCHEDULE command.

2 Backup the JAMS database.

3 Issue the JAMS START SCHEDULE command.

The JAMS_MONITOR and JAMS_NETWORK processes also have files
open for write access. The JAMS_MONITOR opens the JXQ.DAT and
JCQ.DAT files for write access and the JAMS_NETWORK has the
NWIP.DAT file open for write access. These files are used to pass data
between the Monitor, Schedule and Network processes. This data is
transient and there is no need to backup these files. If these files ever
become corrupt or lost, they can be recreated by performing the following
steps:

1 Stop the Monitor, Schedule and Network processes on all nodes in the
cluster.

2 Delete the JCQ.DAT, JXQ.DAT or NWIP.DAT files in the JAMS_DATA
directory.

3 Start the Monitor processes (which will create new JCQ.DAT and
JXQ.DAT files and start the Schedule and Network processes).

11.6 JAMS Queue Characteristics
JAMS uses OpenVMS queue characteristics to prevent batch jobs from
executing (assuming the Job in question utilizes queues). The JAMS_
WAITING and JAMS_SCHEDULE queue characteristics should never
be assigned to a batch queue because this would defeat the purpose of
assigning the characteristic to a job (namely preventing the job from
starting).
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The following table lists the queue characteristics which may be assigned
to a Job and the reason they are assigned to a job. These characteristics
are defined the first time that the JAMS_SCHEDULE process starts.

Characteristic Reason

JAMS_SCHEDULE This Job needs to be examined by the JAMS_SCHEDULE
process to determine if it can be released.

JAMS_WAITING This Job is waiting for a Precheck Job, Dependency or time
slot.

If you notice that a Job remains in a pending state longer than you think
it should, you can use the SHOW ENTRY/FULL entry OpenVMS command
to display all information about the Job. If the Job has characteristics
associated with it, the characteristic numbers are displayed. You can
translate these numbers into the text characteristics with the OpenVMS
command SHOW QUE/CHAR.

If you see Jobs with the JAMS_SCHEDULE characteristic for more than a
few seconds, it indicates that the JAMS Schedule process is not running.
If the JAMS Schedule process is in fact running, it either has a very
heavy work load or it is not working correctly. If you feel that the JAMS
Schedule process is not working correctly, you should try stopping and
starting the JAMS Schedule by using the STOP SCHEDULE and START
SCHEDULE commands.

11.6.1 Production & Debug Characteristics
You can also define queue characteristics to identify production and debug
batch queues. When a Job is submitted by JAMS the /DEBUG qualifier
is used to define whether this is a debug or normal (production) run of
the job. For jobs which are not submitted by JAMS, JAMS will look at
the queue which the job is in, if the queue has the JAMS_PRODUCTION
characteristic then the job is considered a production run. If the queue has
the JAMS_DEBUG characteristic then the job is considered a debug job. If
the queue has neither of these characteristics then a JAMS configuration
field determines whether this is a production or debug run.

If you plan to use the JAMS_PRODUCTION and/or JAMS_DEBUG
characteristics, you must define the characteristics manually.
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